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MACUSER News and Analysis About 
Macs, OS X, and AppleMACUSER News and Analysis About 
Macs, OS X, and Apple

Apple might make its virtual assistant one of the flagship features in OS X 10.12.

BY CAITLIN McGARRY

Siri for Mac reportedly coming 
this fall, at long last
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A
pple put Siri, its voice-activated personal assistant, in 
the iPhone, iPad, Apple Watch, and Apple TV, but not 
the Mac. I assumed the company realized that people 
talking to their computers would be rage-inducing to 

those around them, but OS X has had dictation features for a 
while, and Apple has actually been testing Siri on the Mac for the 
last four years.

The feature is almost ready to go, 

9to5Mac reported recently (go.

macworld.com/9to5siriosx), and will 

be announced at the annual World-

wide Developers Conference as part 

of OS X 10.12 in June. The next 

version of the Mac operating system 

is likely to get a public release this fall.

So how will Siri on the Mac work? 

Kind of like Spotlight search, in that a 

Siri icon will sit in your menu bar until 

you need to use it. Click it, and a 

transparent overlay will pop up in the 

top right of your screen with the 

same colorful waves you see on your 

iPhone screen, which indicates that 

Siri can hear you speaking. If your 

Mac is plugged in, you’ll be able to 

say “Hey, Siri” and get a response 

without clicking.

It’s unclear exactly why Apple 

waited so long to bring Siri to OS X, 

but according to 9to5Mac, the 

company may not have had a good 

idea of what it would be useful for 

(I’m still skeptical, to be honest), or 

what the interface should look like. 

Those problems have reportedly 

been resolved.

Why this matters: Some Mac 

users have been waiting for years—

since Mountain Lion (go.macworld.

com/mountainlion)—for Apple to put 

Siri in OS X. I don’t get the appeal, 

but I’m open to the idea if Siri 

proves to be incredibly useful on the 

Mac. ■

77
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Apple shuts down first-ever 
ransomware attack against 
Mac users
The ransomware was seeded inside a legitimate BitTorrent application 
called Transmission.

BY JEREMY KIRK

MACUSER

8
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W
ith the help of security researchers, Apple recently 
quickly blocked a cyberattack aimed at infecting 
Mac users with file-encrypting malware known as 
ransomware.

The incident is believed to be the  

first Apple-focused attack using 

ransomware (go.macworld.

com/5ransomware), which typically 

targets computers running Windows.

Victims of ransomware are asked 

to pay a fee, usually in bitcoin, to get 

access to the decryption key to 

recover their files.

Security company Palo Alto 

Networks wrote that it found the 

“KeRanger” ransomware wrapped 

into Transmission, which is a free 

Mac BitTorrent client. 

Transmission warned on its 

website (transmissionbt.com) that 

people who downloaded the 2.90 

version of the client “should immedi-

ately upgrade to 2.92.”

SNEAKING PAST THE 

GATEKEEPER

It was unclear how the attackers 

managed to upload a tampered 

version of Transmission to the 

application’s website. But compro-

mising legitimate applications is a 

commonly used method.

“It’s possible that Transmission’s 

official website was compromised 

and the files were replaced by 

re-compiled malicious versions, but 

we can’t confirm how this infection 

occurred,” Palo Alto Networks wrote 

on its blog (go.macworld.com/

transmissionin-

fected).

The tainted 

Transmission 

version was 

signed with a 

legitimate 

Apple devel-

oper’s certifi-

cate. If a Mac 

user’s security 

settings are set 

to allow 

downloads from identified Apple 

developers, the person may not see 

a warning from Apple’s Gatekeeper 

(support.apple.com/en-au/HT202491)

that the application could be danger-

ous. Security researcher Patrick 

Wardle of Synack has previously 

disclosed flaws in Gatekeeper (go.

macworld.com/gatekflaws) that can 

lead to malicious code being 

installed from seemingly legitimate 

sources.

Apple revoked the certificate after 

being notified, Palo Alto wrote. The 

THE INCIDENT IS 
BELIEVED TO BE 
THE FIRST APPLE-
FOCUSED ATTACK 
USING RANSOMWARE, 
WHICH TYPICALLY 
TARGETS COMPUTERS 
RUNNING WINDOWS.
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company has also updated its XPro-

tect antivirus engine.

After it is installed on a system, 

KeRanger waits three days before 

connecting to a remote command-and-

control server using the Tor system. It 

is coded to encrypt more than 300 

types of files.

The ransom is 1 bitcoin, or about 

$404.

RANSOMWARE IS HARD  

TO CATCH

There are few defenses against 

ransomware. Antivirus programs often 

do not catch it since the attackers 

frequently make modifications to fool 

security software. The best method is 

to ensure files are regularly backed up 

(go.macworld.com/macbackup) and 

that the backup system is isolated (go.

macworld.com/whycrashplan) in a way 

to protect it from being infected as well.

Disturbingly, KeRanger appears to 

also try to encrypt files on Apple’s 

Time Machine, its consumer backup 

drive, Palo Alto wrote.

Ransomware schemes have been 

around for more than a decade, but 

over the last few years have spiked.

At first the attacks struck consumer 

computers, with the aim of extracting a 

few hundred dollars. But it appears 

attackers are targeting companies and 

organizations that may pay a much 

larger ransom to avoid disruption.

Recently, a Los Angeles hospital 

said it paid (go.macworld.com/hospital-

pays17k) a $17,000 ransom after saying 

it was the quickest, most effective way 

to restore its systems. The ransom-

ware had affected its electronic 

medical records.

Although OS X’s share of the 

desktop computing market is much 

lower than Microsoft’s, cyberattackers 

have been showing increasing interest 

in it. But so far, ransomware hasn’t 

been a problem, although some 

research-

ers have 

created 

proof-of-

concept 

file-

encrypting 

malware 

for Macs.

Last November, Brazilian security 

researcher Rafael Salema Marques 

published a video (youtu.be/9nJv_

PN2m1Y) showing how he coded 

ransomware for the Mac in a couple of 

days. He didn’t release the source 

code.

Also, OS X security expert Pedro 

Vilaca posted proof-of-concept code 

on GitHub (github.com/gdbinit/gopher) 

for Mac ransomware he wrote, another 

experiment showing how simple it 

would be for attackers to target the 

platform. ■

RANSOMWARE ATTACKMACUSER

RANSOMWARE 
SCHEMES HAVE BEEN 
AROUND FOR MORE 
THAN A DECADE, BUT 
OVER THE LAST FEW 
YEARS HAVE SPIKED.
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12 Apple TV games worth 
buying a gamepad for

BY ANDREW HAYWARD

MACUSER
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N
ew games come out pretty frequently for the Apple TV, 
and while there are thankfully more games that work 
well with the Siri Remote, there are also many that just 
cry out for a dedicated gamepad. Many of these are 

console favorites—or console-inspired games—that just aren’t 
meant for a small touchpad, and a gamepad goes a long way 
toward making your Apple TV feel like a proper gaming machine.

Included here are 12 of our favorite 

Apple TV games that are best 

experienced with a gamepad, but 

we’re not claiming that each indi-

vidual game warrants an investment 

in extra hardware. Rather, collectively, 

they show how much widespread 

benefit you’ll get from a controller, 

and why it’s a crucial pickup if you 

have plenty of Apple TV couch 

gaming in your future. And if you’re 

looking for MFi (Made for iOS) 

gamepad recommendations, we have 

those as well (go.macworld.com/

gamepads).

 XENOWERK is an arcade-style game built for analog sticks

13
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APPLE TV GAMESMACUSER

Activision’s Geometry Wars is one of the greatest dual analog stick show-

cases ever created, delivering effortlessly (and endlessly) amusing arcade 

shooting with one stick for movement and the other for firing. Sadly, it doesn’t 

convert too well to the Siri Remote: Automating firing makes it more manage-

able, but the tiny touchpad makes movement feel too fidgety. 

Add in a gamepad, however, and Geometry Wars 3: Dimensions Evolved 

($10; go.macworld.com/GeometryWars3) is every bit as brilliant as it is on 

Xbox and other consoles, with precise and challenging combat that will keep 

you coming back to improve your high scores. And Dimensions Evolved is 

absolutely packed with content, including a campaign and the classic arcade 

modes of earlier entries.

 1      Geometry Wars 3: Dimensions Evolved
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Why would video game pinball need a full gamepad? Zen Pinball (free; go.

macworld.com/zenpinball) is worth experiencing either way, but swiping the 

Siri Remote’s touchpad just doesn’t give you that satisfying click of frantically 

jamming a paddle button. Grab a gamepad and you can flick the triggers to 

bat the digital ball around the dozens of available boards. 

Zen Pinball is excellent on the iPhone and iPad, and it’s even better on the 

Apple TV, with the same large library of original and licensed tables available 

to purchase. You get one table free, with others—including many Marvel, Star 

Wars, and South Park ones—sold for $2 apiece with unlimited play. Buttons 

just feel a lot more responsive here than Siri Remote swipes.

 2      Zen Pinball  
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APPLE TV GAMESMACUSER

Octodad: Dadliest Catch ($5; go.macworld.com/octodad) is like nothing 

you’ve ever played before, in part because it’s a game about hiding out in 

suburbia as an octopus amidst an unaware human family. It’s also unique 

because to nail that “simulation,” the developers made the game intentionally 

cumbersome, which is a very tricky approach for a game you’re meant to 

enjoy. 

While solidly playable with the Siri Remote, Octodad is a lot more fun with a 

gamepad, as it removes the frustration of needing to switch between upper 

tentacles (for grabbing things) and lower ones (for walking). Octodad is worth 

experiencing on any device you have, including an iPhone or iPad, but this 

former console game really shines on a big screen with a gamepad.

 3      Octodad: Dadliest Catch
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Spend a couple minutes with Modern Combat 5: Blackout (free; go.macworld.

com/modcom5) using a Siri Remote and you’ll quickly learn that they really, 

really aren’t meant to be together. Gameloft’s first-person shooter automates 

player movement when using the Siri Remote, but the resulting experience is 

incredibly awkward and fumbly, and really not worth the hassle.

Luckily, a gamepad solves all problems here: Modern Combat 5 emulates 

the Call of Duty console game template, and it feels right at home with analog 

sticks and triggers. The quick-hit missions are solid fun, and the multiplayer 

combat is a delight if you can find enough players to face off against. And it’s 

free, albeit with an energy system and paid perks to contend with.

4      Modern Combat 5: Blackout
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APPLE TV GAMESMACUSER

Transistor ($10; go.macworld.com/transistor) was one of the first big games 

available for the Apple TV, and it’s clear that a lot of work went into making it 

fit on the Siri Remote. Through some clever streamlining and configuring, it’s 

relatively easy to experience this dazzling sci-fi adventure with just the Siri 

Remote, although jamming a lot of commands onto the tiny device can make 

things feel cramped.

And that’s where a gamepad provides some welcome breathing room. 

Transistor was originally designed for a proper controller, and with it, you’ll 

have sharper control of heroine Red and be more comfortably able to interact 

with and explore the city. It’s not only a big-screen showcase, but also a nicely 

meaty quest, so this is one well worth enjoying with a gamepad.

 5      Transistor
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Real Racing 3 (free; go.macworld.com/realracing3) is the best simulation-style 

racing game on iOS, and it’s much the same on the Apple TV, delivering loads 

of licensed cars and numerous real-life tracks to zip around—and it looks 

really sharp on the big screen. The Siri Remote’s tilt controls work solidly for 

steering, and if you’re only playing casually, it’ll do the trick. 

Switching to a gamepad makes it feel much more like a console-like 

simulation, however, offering more precise steering and better control over 

acceleration and braking. Real Racing 3 scales well between those two 

experiences, but it’s especially great with a gamepad, and really gives the 

Apple TV some console gaming cred in the process.

 6      Real Racing 3
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APPLE TV GAMESMACUSER

This one requires some explanation (go.macworld.com/disneyvsskylanders): 

You’ll need the Disney Infinity: 3.0 Edition starter pack (go.macworld.com/

disneyinfinity) to play the full game, and it actually comes with the great 

SteelSeries Nimbus controller. It’s also priced at $80 as of this writing, but the 

gamepad itself would be $50. So what do you get?

Well, you get a full-fledged Star Wars console game, along with two smart 

chip–equipped figurines and a Bluetooth base that pulls those characters into 

the game. You can also add on new Star Wars, Marvel, and Disney adven-

tures, and use a wide array of Infinity figurines in the Toy Box mode to create 

and share your own little games and worlds. It’s a big, exciting game, and well 

worth the investment if you love Disney’s myriad properties. And if you’re 

planning on buying the Nimbus anyway, this is a perfect way to do so.

 7      Disney Infinity: 3.0 Edition
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Meanwhile, if you want a game that looks and plays like a big console adven-

ture, but lacks the heft, extra plastic, and big price tag of something like Disney 

Infinity, give a strong look to Oceanhorn ($9; go.macworld.com/oceanhorn). 

This iOS original is strongly modeled after Nintendo’s Legend of Zelda series, 

but the action role-player deftly avoids feeling like a half-hearted clone. 

The Siri Remote’s touchpad isn’t the best option for 3D character movement, 

as it can feel a bit confined, although Oceanhorn does a fair job of making this 

adventure playable with your thumb alone. Switch to a gamepad, however, and 

Oceanhorn better resembles the classic games it emulates, giving you precise 

control of your hero on land and at sea.

 8      Oceanhorn
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APPLE TV GAMESMACUSER

The most ideal way to play Skylanders Superchargers (free; go.macworld.

com/skylanders) is to buy the starter kit, which sells for $50 to $75 (go.

macworld.com/skylanderstarter) and comes with a couple of smart toys, a 

Bluetooth portal, and a small gamepad that only works with Skylanders. But 

if you already have an Apple TV gamepad—and/or you don’t want all that 

expense and plastic—you can just download the app and buy the content 

within. 

The full Superchargers game is sold as a $20 in-app purchase, and that 

gets you a full-fledged console action game, complete with on-foot beat-

’em-up action and various vehicle missions that let you race and fly. And the 

free initial download lets you try out the game before you consider shelling 

out for more. Like Disney Infinity, it offers up a fun, kid-friendly adventure 

and really makes your little set-top box seem like a proper game console.

 9      Skylanders Superchargers
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 10     AG Drive

Many iOS games have tried to replicate the intense fun of anti-gravity racing 

classics like F-Zero and Wipeout, but AG Drive ($4; go.macworld.com/agdrive) 

is the only one that deserves to be mentioned in the same breath as those 

greats—and it’s on the Apple TV, as well. It looks fantastic and has thumping 

techno beats to match, and like Real Racing 3, there’s a precision upgrade to 

using a gamepad. 

AG Drive has you hold the Siri Remote sideways and keep your thumb on 

the touchpad, sliding in either direction to whip around the wild curves. This 

works well enough, but using an analog stick makes steering feel so much 

smoother and gives you more command on the track. And AG Drive isn’t an 

easy game, so every little bit of added control helps.

23
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APPLE TV GAMESMACUSER

DuckTales is a proper old-school game from the 8-bit era, which means it 

doesn’t really have a use for analog sticks and trigger buttons—but even a 

relatively simplistic 2D platformer isn’t best experienced with the Siri Remote. 

It’s solid enough, with the touchpad used for movement and all other actions 

mapped to the play/pause button, but that scheme sacrifices some fluidity of 

movement and action. 

Meanwhile, a gamepad has a directional pad and at least a couple of 

dedicated buttons for jumping and using Scrooge McDuck’s cane as a pogo 

stick or weapon, which make this updated classic a lot more enjoyable. And 

DuckTales: Remastered ($5; go.macworld.com/ducktales) has crisp, redone 

graphics that look really superb on a TV screen.

 11      DuckTales: Remastered
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 12      Xenowerk

Like Geometry Wars 3, Xenowerk (go.macworld.com/xenowerk; $2) is an 

arcade-style game built for analog sticks, as you guide a gun-toting heroine 

through alien-infested facilities. But unlike Geometry Wars 3, I wouldn’t try to 

play Xenowerk with the Siri Remote for more than a couple minutes. The 

scheme is very awkward, and it honestly takes away from the tension and 

excitement of the game.

Luckily, this is a very fun little shooter to experience if you do have a 

gamepad, as the twin-stick controls work well for movement and blasting, and 

there’s a visceral thrill to the combat. It can be repetitive, but it’s very easy to 

get your couple bucks of fun out of Xenowerk.

25
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Reviews

MACUSER

MAC GEMS ARE APPS THAT OFFER 

STANDOUT UTILITY OR UNIQUE 

FEATURES AT A GREAT PRICE.

AIRFOIL 5 IS A DIGITAL VENTRILOQUIST that lets you throw your 

computer’s “voice.” The latest version builds on the foundation of 

letting you take a single app’s audio output and route it to one or 

more places to play it back. It’s something like iTunes multi-“speaker” 

support but with much more control, and it works with any applica-

tion, all while not relying entirely on AirPlay.

SOFTWARE

AIRFOIL 5: AUDIO UTILITY  
PUMPS UP THE VOLUME  
WITH BLUETOOTH SUPPORT,  
AIRFOIL SATELLITE, AND MORE
BY GLENN FLEISHMAN

AIRFOIL 5

mmmmm

PRICE WHEN RATED

$29 new, $15 upgrade (free to 
purchasers of previous version 
after Nov. 1, 2015)

COMPANY

Rogue Amoeba Software

The Latest Mac Products 

Reviewed & Rated

26

http://www.softgozar.com


Airfoil (rogueamoeba.com/airfoil/mac) can target any AirPlay destina-

tion, as it’s long been able to. In my house, that includes an older and 

current-generation Apple TV, a Yamaha stereo receiver during a brief 

period of rudimentary but functional AirPlay support, two computers via 

Airfoil Satellite (rogueamoeba.com/

airfoil/#satellite) (also discussed in this 

review), and a Jawbone Mini Jambox (via 

Bluetooth). Airfoil Satellite can stream to 

iOS and Windows 10 devices and Airfoil 

Speakers in Android. That’s a lot of 

options.

Airfoil 5 runs on a Mac, or run the 

similarly updated Airfoil 3 on Windows, 

(rogueamoeba.com/airfoil/windows) and 

can dynamically turn on and off available 

audio output devices. Every speaker has a 

separate volume control that lets you 

balance sound. You can also lock these 

adjustments to system output, so you can 

raise and lower all volume by adjusting 

your OS X’s control.

The input to Airfoil 5 can be any running 

app or, amusingly, any input source. If 

you’ve got a microphone, you could use 

Airfoil 5 as part of a public address system 

(albeit with some delay). You can also 

select System Output, the aggregate total 

of all sound in OS X that’s directed to the 

default audio device, and then distribute 

that among other speakers and systems.

The secret sauce in Airfoil is how it 

keeps everything in sync: It tries to deter-

mine and match latency—the delay 

between data being sent and played as 

sound—to the most-lagging device. This 

generally works, even as it introduces a 

slight delay whenever you press play, 

AIRFOIL OFFERS SEPARATE 

volume controls for every 

device available as an 

output source.
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pause, or switch audio inputs. It’s worth it to avoid the weird echo effect 

that otherwise can occur. In testing, it worked like a charm, creating rich, 

broad sound. Airfoil routes stereo sound by design, although encoded 

audio (like Dolby Digital) may make it through intact from a source to a 

destination capable of decoding and playing it as intended. Rogue 

Amoeba tells me that they don’t test for this feature or support it, so 

don’t rely on it.

If you have trouble with a given output’s sync, a new Advanced 

Speaker Options dialog (in the Speakers menu) lets you tweak the delay. 

REVIEWS  |  AIRFOIL 5MACUSER

THE NEW GROUPS option lets 

you create collections of 

speaker combinations you 

use routinely.

28
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That menu also lets you hide speakers that you never want to use with 

Airfoil, reducing clutter in your output display.

MORE NEW FEATURES

Bluetooth support is new and extremely welcome, given all the 

Bluetooth-connected speaker and headphone options now available. 

Any device paired with your Mac can 

be selected in any combination.

Another useful new feature is 

Audio Groups, set in Preferences, 

which lets you name a set of speak-

ers making it just a single click to 

swap among preset collections.

Yet another set of new features is 

also in Preferences in the Auto mation 

tab. Airfoil can be set to automatically 

begin transmitting to a selected set of 

speakers when it’s launched, so this 

is a way to set up your preferences 

without clicking a thing with Airfoil as 

an OS X startup item, or whenever 

you launch Airfoil. The same tab also 

has an automatic disconnect option, 

which releases remote speakers that 

can only accept one source at a time 

after Airfoil has been transmitting 

silence for a set period of time, which 

defaults to 5 minutes.

AIRFOIL SATELLITE

Airfoil works with a refreshed version 

of its remote speaker software, now 

called Airfoil Satellite. It’s available at 

no additional cost for OS X, Windows, 

and iOS. Airfoil Satellite can remotely 

have Airfoil send it audio if it’s not 

selected on the host machine, and 

A NEW SYSTEM menu provides 

access to almost all of 

Airfoil 5’s features without 

switching to the main app.
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can even remotely control Airfoil with 

essentially a duplicate of its main control 

interface. (Both options can be disabled in 

Airfoil’s preferences, too, if you’re in a more 

complicated network environment.)

With iTunes as the audio source, Airfoil 

Satellite can pause and resume playback, 

as well as jump back and forth a track. It 

also displays the now-playing track 

information.

Airfoil Satellite only works with the latest 

version of Airfoil. The older Airfoil Speakers 

software remains available for Android and 

Linux, and is also free, but can’t take 

advantage of the newer remote control and 

remote activation options.

Airfoil 5 is $29, or $40 in a Mac and 

Windows bundle. Purchasers of Airfoil 4 

starting November 1, 2015, receive a free 

upgrade; contact Rogue Amoeba if email 

didn’t arrive with details. Owners of that 

release from before that date can pay $15 

for the full version. A free trial download 

works identically to the paid version for 10 

minutes and then overlays noise.

BOTTOM LINE

As a user of Airfoil for many years, this 

latest release’s new skin certainly makes it 

seem more up to date, but all the changes 

beneath the sleeker look make it more 

useful with a greater variety of audio 

devices and situations. ■

REVIEWS  |  AIRFOIL 5MACUSER

AIRFOIL SATELLITE REFRESHES earlier software that turns a computer 

or iOS device into a remote speaker for Airfoil.
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PRO PLAYER 2.1

mmmm
PRICE WHEN RATED

$30

BELIEVE IT OR NOT, QuickTime 

turns 25 years old this year. The 

multimedia software that debuted 

with System Software 6 (?!) soon 

became the de facto method for 

playing video on the Mac, eventually 

introducing an optional Pro upgrade 

that allowed users to perform basic 

edits, merge files, and export to 

supported video codecs.

With the release of Mac OS X 

Snow Leopard and QuickTime X in 

2009, Apple went back to basics, 

stripping QuickTime Player X of most 

pro-centric functionality. Over time, 

some features like Trim would return, 

but in the eyes of power users, the 

damage was done.

There’s been no shortage of 

powerful media players ever since, many capable of playing just 

about any file you can throw at it, even without proper codecs 

installed. But these alternatives are often designed for power users, 

rather than content creators who require a fast, lightweight player for 

reviewing files.

EDITOR’S BEST FRIEND

Pro Player 2 (digital-heaven.co.uk/pro-player) falls into the latter 

category, but it’s important to note up front that this application is 

designed strictly for playback of MOV, MP4, and audio files, rather 

SOFTWARE

PRO PLAYER 2: ROLL OUT THE 

RED CARPET FOR THIS PRO 

QUICKTIME PLAYER
BY J.R. BOOKWALTER
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than the “everything but the kitchen sink” approach of open-source 

players like VLC (videolan.org/vlc). There are no editing tools or MPEG 

support, and if you’re hoping to rip Blu-rays to MKV and watch on the 

Mac, you’ll be disappointed.

On the other hand, if you want to view ProRes or MXF video files with 

a large timecode display and buttons that don’t obscure the picture, con-

trol playback using keyboard commands, or listen to specific tracks on 

multichannel audio files, this is most definitely the software you’re 

looking for. (Note: MXF playback requires Final Cut Pro, Motion, or 

Compressor installed on the same system.)

In addition to playback, the app includes a browser where users can 

add frequently used folders or access recently opened files, along with a 

faux “desktop” for previewing multiple files, complete with interactive 

thumbnails you can scrub through. But it’s not cheap: After a brief 

flirtation as a free app with optional Plus Pack upgrade to unlock higher-

end features, Pro Player 2 now costs a flat $30 starting with version 2.1.

REVIEWS  |  PRO PLAYER 2MACUSER

PRO PLAYER 2 isn’t the 

cheapest QuickTime 

player around, but it’s 

definitely one of the few 

designed with pro content 

creators in mind.
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KEYBOARD JOCKEY

That’s just as well, because the app is designed as a companion to 

traditional content creation software like Final Cut Pro or After Effects, 

which cater to a non-consumer audience. Instead of waiting for heavy-

weight applications to launch just to take a quick spin through a Quick-

Time file, Pro Player 2 allows you to dive in immediately with few com-

promises.

Compared to other media player apps, Pro Player 2 can be controlled 

almost entirely from the keyboard. For starters, the player implements 

familiar “JKL” shortcuts found on most editing software, used to play 

backward, pause, or play forward; each additional press shuttles play-

IN ADDITION TO PLAYBACK,  

Pro Player 2 includes a 

browser for managing 

favorite folders, recent files, 

and more.

KEYBOARD SHORTCUTS are 

prevalent in Pro Player 2, 

which can also be used to 

key in specific timecode 

numbers like a pro.
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back faster in the desired direction, or you also can click and hold the 

mouse to shuttle or jog.

In addition to playback, there are keyboard shortcuts for toggling 

between Browser and Player modes, full-screen viewing (with or without 

on-screen controls), and the ability to mark in/out points to play or locate 

specific sections of a video; clicking the current time display can also be 

used to precisely jump to a specific frame. The M key mutes all audio 

playback, and motion graphics designers can even toggle alpha channel 

display.

FAMILIAR UI

Like QuickTime Player X, Pro Player uses a dark background theme to 

keep the focus on the content being played. But that’s where the 

similarity ends: The user interface has the familiar look and feel of video 

editing software, with selection, playback, and audio controls left, right, 

and center, respectively. If the open file contains a timecode track, Pro 

Player displays it by default, but users can also view in absolute time or 

frames.

Pro Player shows the filename in the lower left corner, complete with 

runtime, file size, data rate, and number of tracks. Video format, frame 

rate, and size information is displayed at right, along with accompanying 

audio format, track arrangement, and bitrate; for multitrack QuickTime 

files, individual audio tracks can be muted or soloed, with a single fader 

to control volume.

Aside from a slightly more affordable price, there’s really only one 

REVIEWS  |  PRO PLAYER 2MACUSER

NEED TO PLAY a specific 

section of a video 

repeatedly? Mark in and out 

points to limit Pro Player 2 to 

only that selection.
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thing Pro Player 2 needs: Support for 

video playback to external devices from 

manufacturers like Blackmagic and 

Matrox. I have two such pieces of Thun-

derbolt hardware attached to my 15-inch 

MacBook Pro with Retina Display, but 

neither outputs audio or video to my 

connected monitors. This means play-

back is only as accurate as an attached 

Mac display, which isn’t recommended for 

color or other quality control, particularly 

with older interlaced video files.

BOTTOM LINE

As a companion app for content creators, Pro Player 2 is well worth the 

asking price, but the lack of external display hardware support keeps it 

from being as “pro” as it could be. ■

AUDIO OR VIDEO files with multiple channels can be independently muted 

or soloed for previewing specific tracks.
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SATECHI TYPE-C 

PASS THROUGH 

USB HUB WITH 

USB-C CHARGING 

PORT

mmmmh
PRICE WHEN RATED

$45

COMPANY

Satechi

MACBOOK DOCKS have started to arrive a year after Apple intro-

duced its single-port USB-C–based ultra-portable MacBook (go.

macworld.com/usbcmacbook), and the Satechi Type-C Pass Through 

USB Hub (go.macworld.com/satechihub) with USB-C Charging Port is 

one that will fit a lot of users’ needs at an affordable price. Of special 

interest is its inclusion of USB-C pass-through power, something 

that’s popping up all over suddenly, letting you continue to keep a 

MacBook charged while using external ports.

The dock is tiny and handsome in brushed aluminum available in 

HARDWARE

SATECHI USB-C  
PASS THROUGH HUB:  
TINY, POWERFUL EXTENSION  
FOR ON-THE-GO
BY GLENN FLEISHMAN

MACUSER
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colors matching Apple’s three MacBook options, gold, silver, and space 

gray. For Mac users, the Satechi logo and branding on the top may be too 

much, but you’re in luck! Because USB-C is reversible, you can use the 

dock, which has an integral connector, either sticking out past the back of 

the Mac (showing the branding) or tucked in toward the trackpad end, 

unadorned. The USB-C connection can’t be used for data, only for power.

The dock has four ports in addition to the USB-C pass-through: two 

USB 3.0 Type-A jacks, one full-size SD card slot, and a microSD slot. In a 

previous model (go.macworld.com/satechiusbchub) of the Satechi dock 

that lacks the power pass-through, the memory card slots couldn’t be 

used simultaneously. While Satechi says that’s the case with this dock as 

well, I was able to mount both card types and copy between them.

The microSD slot is awkward, though that’s true of all similar slots. The 

card has to be inserted flipped (logo on bottom) when the dock’s logo is 

facing up. I inserted it the wrong way around and had to use a pair of 

pliers to remove it very carefully. I’d recommend using an SD card adapter 

(which ships with most microSD cards) unless you can train yourself. The 

SD slot is also slightly awkward: You only need to push the card in a very 

small amount, just enough to cover the exposed pins.

I tested the Type-A ports with a reference 

external bus-powered USB 3.0 2TB 

WD My Passport Ultra hard 

drive, and it 
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performed at the same rate as 

direct USB-C connection, 

90MBps for both read and 

write. This is about 20 percent 

off its maximum speed accord-

ing to sites that benchmarked 

the drive. (The MacBook’s internal 

SSD measured 120MBps for writes 

and 300MBps for reads.)

The SD card slots fared just as poorly as they 

do using Apple’s USB-C to Type-A adapter and a 

generic card reader: with a “45MBps” UHS-I Class 10 SD 

Card, about 33MBps write speed and 37MBps read rate and 

about 12MBps write and 36MBps read for an identically rated 

microSD card. (The MacBook with a card reader sometimes reached 

14MBps for writes, but that’s negligibly different and wasn’t consistently 

repeatable.)

BOTTOM LINE

Weighing in at 0.64 ounce and measuring 3.31 by 1.06 by 0.3 inches 

(plus a projecting USB-C jack), and costing just $45, the dock is a 

perfect lightweight counterpart to the MacBook that replaces two to four 

other adapters and devices, most of which won’t pass USB-C power. ■

REVIEWS  |  SATECHI USB-C HUBMACUSER
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KANEX DIGITAL 

AUDIO ADAPTER 

FOR APPLE TV

mmmmh
AT A GLANCE

Handy adapter that passes 
through video over HDMI from 
an Apple TV while splitting out 
audio in both stereo and 
surround-sound formats.

PROS

•  Well-produced audio splitter

•  Decodes 5.1 and 7.1 surround 
sound

•  Has both 3.5mm audio and 
SPID/F optical audio 
interfaces

CONS

•  Relatively expensive

PRICE

$60

COMPANY

Kanex

WHEN THE FOURTH-GENERATION Apple TV (go.macworld.com/

appletv4) came out, the complaint I expected least was the lack of 

an audio output port (go.macworld.com/appletvoutput). That’s 

because I own a relatively new receiver that handled HDMI audio 

and video switching; while not rare, it’s nowhere near common. 

Many people rely on older receivers that can’t switch HDMI and 

extract the audio, use standalone powered speakers that require a 

separate audio signal, or prefer receivers that omit digital video 

functions.

Kanex has a solution for everyone who fits that description, the 

Digital Audio Adapter for Apple TV (kanex.com/hdmi-optical-audio). 

The only downside is its $60 price tag—although far cheaper than 

HARDWARE

KANEX DIGITAL AUDIO ADAPTER 

FOR APPLE TV: COMES TO THE 

RESCUE OF APPLE TV OWNERS
BY GLENN FLEISHMAN
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getting an HDMI-switching receiver.

The Kanex adapter is, in essence, an HDMI shunt: It has a short 

integral HDMI cable to plug into an Apple TV (or a Roku, an Amazon Fire 

TV, or other devices), and an HDMI port to accept a cable that connects 

to a TV set. You can plug it inline with an existing setup. It supports 

HDMI 1.4 and ostensibly passes through every high-definition format and 

resolution currently available. It has both S/PDIF optical digital and 

3.5mm stereo audio ports, which make it universally compatible.

The drawback is that it requires power, although it includes a neces-

sary micro-USB cable and compact AC adapter that has the same size 

and shape as one for an iPhone. You wind up moving around a fair 

amount of gear to get it hooked in, but that’s a one-time issue. In my 

case, I needed to feed the power cord out the back of my A/V cabinet, 

then slightly disassemble the receiver setup to route the TOSlink optical 

digital cable into the S/PDIF.

The S/PDIF support includes both 5.1 and 7.1 surround sound; Kanex 

says any uncompressed, encoded format will work, like DTS Digital and 

Dolby Digital. I tested this with an iTunes-purchased movie and a fourth-

generation Apple TV, dutifully listening closely to each of my five speak-

REVIEWS  |  KANEX DIGITAL AUDIO ADAPTERMACUSER

THE KANEX (at left) is 

compact, sleek, and well 

designed, but it’s got lots of 

jacks and plugs to manage.
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ers and subwoofers, and heard crisply 

delineated separation.

The 3.5mm stereo output can be used 

with powered speakers or as an input to a 

receiver that lacks S/PDIF support, but it even 

works with headphones. There’s no volume 

control in the Kanex, and the Apple TV’s volume 

controls only the HDMI endpoint (like a TV set), 

so if you want to control playback level you 

need headphones with an inline slider or dial. 

(Also make sure to set the Apple TV’s audio 

settings to stereo if you had it on surround 

sound, otherwise it won’t decode properly.)

Also note that the Kanex can only have one 

type of audio jack connected at once. That 

shouldn’t be a problem for most people. But if 

you swap among sources, be sure to unplug it 

from its power cable, remove one audio and 

replace the other, then plug the power adapter 

back in. With two plugs jacked in, Kanex says 

you’ll encounter problems.

Kanex notes, I suppose for completeness, that its adapter doesn’t 

block AirPlay mirroring to the Apple TV. It’s really a straight HDMI 

pass-through, so it shouldn’t, but I expect some buyers want additional 

reassurance.

The $60 price tag is the only thing that’s going to be a sticking point 

for some. You can get splitters with some part or all of the functionality 

for a third to half as much. But those come from no-brand-name compa-

THERE’S NO VOLUME 
CONTROL IN THE KANEX, 
AND THE APPLE TV’S 
VOLUME CONTROLS ONLY 
THE HDMI ENDPOINT 
(LIKE A TV SET), SO IF 
YOU WANT TO CONTROL 
PLAYBACK LEVEL YOU 
NEED HEADPHONES WITH 
AN INLINE SLIDER OR DIAL. 
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nies, have few online 

reviews, and typically 

have an industrial look 

to them compared to 

the sleek shiny black finish 

of the Kanex model. These 

off-brand items also occupy 

about four to six times the volume 

of the Kanex, which is quite 

compact.

BOTTOM LINE

Kanex’s Digital Audio Adapter for Apple TV 

is elegant and comes with the backing of its 

reputation for managing technical support and 

manufacturing problems. For a plug-and-forget-it device you want to 

work reliably, the extra price likely doesn’t work out to extra in the long 

term. ■

REVIEWS  |  KANEX DIGITAL AUDIO ADAPTERMACUSER

42

http://www.softgozar.com


What We’re
Raving About
�is MonthHot Stuff

43

ALTWORK DESK

The $5,900 Altwork desk 

(altwork.com) is no ordinary 

workstation. It’s an entirely 

configurable workstation on 

wheels that actually has you 

lay down on your back to 

work. OK, you’re probably 

wondering: Who wants to lay 

down while they’re working? I 

felt the same, until I sat down at 

Altwork’s desk, pressed a button, 

and let the machine gently 

recline until I was on my back 

with a monitor above my 

head. I’m not gonna lie: It 

feels like being the captain 

of a spaceship. But aside 

from the novelty, the ability 

to recline and still see a display and have easy access to a keyboard and 

mouse (thanks to an adjustable desk and magnets) is essential for people 

who have experienced injury or live with chronic pain. —CAITLIN MCGARRY
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Hot Stuff

MACUSER

44

OWC USB-C DOCK

OWC’s $159 USB-C Dock (owcdigital.com) neatly extends a 12-inch 

MacBook to act like a desktop. The OWC dock has a panoply of 

networking and peripheral ports that come close to matching what you 

find on a current Mac mini model (it’s shy one monitor-capable outlet 

compared to the mini). Plug a short USB-C male-to-male charging-com-

patible cable from a MacBook to the appropriately labeled port on the 

AC-powered dock, and the world opens up to you. The dock works in 

OS X and with Windows 10 via Boot Camp. —GLENN FLEISHMAN

http://www.softgozar.com
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TILE

The new Apple TV has the most elegant 

remote control I’ve ever used. It’s thin. It’s 

light. It has cool-to-the-touch aluminum on 

the back, and smooth glass on the front. 

But man, is it easy to lose. That’s how I 

ended up with Tile (thetileapp.com), a $25 

Bluetooth tracker with a built-in speaker . 

There are other Bluetooth trackers on the 

market, but I was drawn to Tile because its 

square, 37mm frame almost perfectly 

matches the 38mm-wide Apple TV remote. 

Now whenever the Apple TV remote gets 

lost, I can open an app on my iPhone and 

press a button to have the remote make a 

sound. It’s seamless. —JARED NEWMAN
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Chewable coffee and the  
Apple Watch: Getting started 
with basic biohacking

iOS CENTRAL �e Latest on the iPhone, iPad, 
iPod Touch, and App Store

I thought hacking your brain seemed extreme. Then I tried Go Cubes.

BY CAITLIN McGARRY
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T
he breakout star of South by Southwest Interactive 
wasn’t a social app or a piece of hardware. It was chew-
able coffee. Little red and yellow packages of caffeine-
packed Go Cubes were all over downtown Austin.

But these weird little latte-flavored 

gummies aren’t just a novelty snack, 

or even an easy way to mainline 

caffeine without having to pee every 

five minutes. Chewing Go Cubes is 

the first step on the road to biohack-

ing, or quantifying your body and 

your brain to achieve maximum 

productivity.

Most people wouldn’t consider 

wearing a fitness band that tells you 

when you’ve walked 10,000 steps in 

a day, using an app to track your 

workouts, or logging your food intake 

forms of biohacking, which, to be 

honest, sounds like a weird, extreme 

practice for people who believe 

we’re closer than ever to The 

Singularity. But if you quantify your 

body’s inputs, like food, and its 

outputs, like exercise, then you’re 

well on your way to being a bio-

hacker. At least that’s what Nootro-

box cofounder Geoff Woo told me.

Nootrobox makes nootropics, or 

powdered supplements designed to 

boost your brainpower, but those 

products have limited appeal for 

regular folks. So the company just 

released Go Cubes, a more main-

stream way to hack your brain, and 

there’s a reason its supply sold out in 

three days on Amazon Launchpad 

(go.macworld.com/gocubesamazon). 

You can buy a box of 20 four-packs 

for $59, or slightly cheaper on the 

Nootrobox website (gocub.es), and 

they come in three flavors: mocha, 

pure drip, and latte. (To be honest, I 

could not taste the difference 

between the three.)

A CHEWABLE BUZZ

Go Cubes are almost exactly as 
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strange as you might imagine. The 

texture is like a Sour Patch Kid, 

though a cube tastes almost exactly 

like a latte. There is a bitter, sour 

coffee center, which some people 

don’t taste and others (like myself) 

taste quite acutely. Unlike liquid 

coffee, the cubes deliver a concen-

trated dose of caffeine in a pocket-

friendly form. There’s a little more to 

the cubes than just efficient caffeine 

delivery, which I’ll dive into in a 

minute. But first, I had to test these 

things—and pass them out to unsus-

pecting coworkers—to see their 

effects on a range of people.

The benefit of eating a Go Cube 

instead of just drinking a cup of 

coffee is the precise hit of caffeine 

you get: 50mg of caffeine in each 

chewable. Two cubes equals one 

cup of coffee. You will definitely feel 

that concentrated dose, in my 

experience. On an empty stomach, 

two Go Cubes made me feel like a 

jittery mess, where a regular cup of 

coffee does not have this effect. 

When I hit my 3:00 p.m. post-lunch 

slump, two cubes turned me into a 

machine of productivity, churning out 

stories and emails like it’s my job 

(and it is, so that worked out).

Some of my human guinea pigs—

my friends and colleagues—couldn’t 

iOS CENTRAL CHEWABLE COFFEE AND THE APPLE WATCH

NOOTROBOX 

COFOUNDERS Michael 

Brandt, left, and 

Geoffrey Woo, right, 

believe the human 

body is the next 

computing platform.
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get past the intense coffee taste, 

which is much stronger than in a 

typical cup of the stuff. Others find 

the effect to be too much like, well, 

crack.

I cajoled my coworker Leah 

Yamshon into trying the cubes while 

we were in Austin. She was tired and 

needed an afternoon pick-me-up. 

She gamely ate two cubes, but the 

look of disgust on her face made me 

burst out laughing. However, she 

admitted later that the cubes got the 

job done—she powered through her 

afternoon with ease.

“I’d rather have an afternoon iced 

coffee,” she said.

HACKING YOUR BRAIN

So they’re not for everyone. But 

there’s a little more to Go Cubes than 

a convenient caffeine hit. Nootrobox 

CEO Woo says nootropics—even the 

mainstream chewable variety like his 

coffee cubes—are designed to 

modulate input and output. So the 

company put L-theanine, an amino 

acid found in tea, in the cubes to 

pump up its cognitive effects. Scien-

tific studies have shown that caffeine 

and L-theanine together (go.mac 

world.com/caffeinetheanine) improve 

your attention while lessening the 

coffee jitters.

That all sounds legit, but more 

studies need to be done—and that’s 

where the self-tracking devices we 

carry with us all the time, like our 

phones, fitness bands, and smart-

watches, come in.

“The biggest knock on the supple-

ments industry is ‘can you actually 

show effects?’” Woo says. “It’s very 

hard to track these things because 

it’s expensive to do clinical trials and 

you’re not getting enough granular 

data. With Apple Watch, we have 

supercomputers on our 

wrists. We’re not only 

innovating on the 

best inputs on the 

human body, but 

we can actually 

capture it.”

Especially if 

the Apple 

Watch one day 

has skin-capac-

itive sensors 

that can sense 

things like 

cortisol levels in 

your sweat.

Capturing that data 

isn’t easy now, but that 

will soon change, Woo says.

He compares the biohackers of 

today with the Homebrew Computer 

Club of the 1970s, which is now 

recognized for seeing then what few 

people could—that personal comput-

ers would change the world. It was in 

this club that the kernel of what 

would become the Apple I was 

THE APPLE WATCH could 

play a key role in 

measuring biohacking 

efforts.
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iOS CENTRAL CHEWABLE COFFEE AND THE APPLE WATCH

formed. So in a few years, biohacking 

won’t be such a crazy idea, Woo 

says. Forget virtual and augmented 

reality: The next platform of comput-

ing is us.

“We’re adjacent to Soylent. 

They’re about replacing food. We’re 

about performance enhancement,” 

Woo says. “Food is one of the 

primary inputs we put into our 

system. If we think about the human 

body as a platform, that correlates 

with outputs. We have information 

about how inputs affect outputs, so 

let’s be rigorous about maximizing 

outputs with inputs.”

I haven’t tried Nootrobox’s other 

nootropic stacks, which are designed 

to activate different parts of your brain 

during the day, but after experiencing 

the Go Cubes’ effects, biohacking 

doesn’t seem like such a bizarre 

concept. Woo called me in the midst 

of a 36-hour fast, which all of Noot-

robox’s employees collectively do 

each week to 

“generate new 

brain cells,” he 

tells me. I love 

food and have 

never fasted in 

my life, but by 

the end of our 

conversation I was trying to figure out 

if I could fit it into my schedule. I want 

new brain cells, too. I don’t know if 

chewable coffee, nootropics, and an 

Apple Watch can turn me into the 

optimum version of myself, but it 

certainly is seductive to think so. ■

FORGET VIRTUAL AND 
AUGMENTED REALITY: 
THE NEXT PLATFORM 
OF COMPUTING IS US.
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NOVELS ROCK ‘N’ ROLL
STAND-UP COMEDY JAZZ
VIDEO GAMES MOVIES
COMIC BOOKS TALK RADIO

EVERY NEW ART FORM HAS ITS FIGHT FOR FREE SPEECH.

OUR TIME IS NOW

V I D E O G A M E V O T E R S . O R G

FIGHT FOR YOUR VIDEO GAMES
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There’s no solid evidence that mobile screens’ color 
temperature is the real culprit to keeping you up at night.

BY GLENN FLEISHMAN

iOS CENTRAL

iOS 9.3: The new Night Shift 
feature probably won’t help 
you sleep better
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T
he Night Shift feature in iOS 9.3 lets you adjust the color 
temperature of the display, shifting away from blue 
spectrums of light, in the putative interest of improving 
sleep. But Apple makes no promises. On its website, 

Apple notes, “Many studies have shown that exposure to bright 
blue light in the evening can affect your circadian rhythms and 
make it harder to fall asleep.” In iOS, the feature is explained with 
“This may help you get a better night’s sleep.”

In fact, this feature likely will have 

little or no effect on most people. 

Apple hasn’t misrepresented any of 

the science, but clinical work done to 

date doesn’t point a finger right at 

mobile devices or even larger 

displays. Night Shift also can’t 

remove enough blue to make a 

difference if that color is the culprit. 

And blue light may not be the trigger 

it’s been identified as. While 

researchers haven’t tested the new 

feature yet, several factors add up to 

at best a placebo effect and a 

reminder to power yourself down.

Apple might have done better to 

create something called Night Safe, 

an option that would countdown the 

moments until you’d be locked out of 

your hardware till morning except for 

emergencies or going through a 

tedious override process—a Do Not 

Disturb on reverse steroids.

Jumping to the chase, if you’re 

ready to crash: If you want to sleep 

better, the almost universal sugges-

tion from both sleep and lighting 

researchers is to turn off any screen 

two hours before your planned 

bedtime. Some also recommend 

using warmer lighting throughout 

your house in sources you use in the 

later evening.

WHY DO YOU FEEL BLUE?

Our circadian rhythm, a biological 

cycle, regulates how our body 

functions and repairs itself, although 

it’s commonly associated with sleep 

and wakefulness. It’s roughly 24 

hours for human beings, and our 

bodies use a number of cues to keep 

us on track. Getting out of sync can 

contribute to illness (go.macworld.

com/cancercircadian), obesity, 

diabetes, and even an increased risk 

of cancer (medscape.com/view 

article/707460).

Researchers have conducted 

studies over decades that isolate 

people from external cues to see 

what a natural cycle looks like, and 

how we sleep and wake. More 

recently, a lot of clinical and survey 
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work has looked into measuring the 

effect of lighting: cycles of light and 

dark, light temperature, brightness, 

and other factors.

A discovery about 20 years ago 

helped make a connection, the limits 

of which are still being felt out. Many 

animals, including humans, produce 

the hormone melatonin across the 

circadian cycle, but it’s suppressed to 

low levels during natural waking 

hours. As it gets dark, that suppres-

sion abates, and melatonin produc-

tion helps us become sleepy and 

remain asleep. (It has many other 

attributes, too, and other hormones 

have cycles that seem less tied to 

sleep.)

Melatonin production 

starts ramping up about 

two hours before your 

body’s natural sleep 

cycle would start—often 

described in research as 

about 10 p.m. in local 

time. And it’s produced 

in the largest quantities 

in the wee hours, 

wherever in the world 

you are, right in the 

middle of what your 

body perceives as the 

darkest time of day.

If you want to sleep 

better, the almost 

universal suggestion 

from both sleep and 

lighting researchers is to turn off any 

screen two hours before your 

planned bedtime.

Since this light receptor type was 

discovered, scientists have con-

nected in many, many studies not 

just light and melatonin suppression, 

but specifically light that’s heavy on 

blue frequencies (go.macworld.com/

bluefrequency). Blue light can 

ostensibly offset the cycle of hor-

mone production by a couple of 

hours or more. This has led to 

speculation that staring at television 

sets, monitors, and mobile displays 

disrupts or delays sleep. If you have 

to get up or are woken up at a fixed 

iOS CENTRAL iOS 9.3: NIGHT SHIFT

NIGHT SHIFT LETS YOU 

schedule a change in 

color temperature, but 

it may not be enough 

to help with sleep 

patterns.
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time, as for most people, this both 

reduces sleep and throws off the 

body’s endocrine and other systems.

Daylight has a large proportion of 

short-wavelength light at the blue 

end of the spectrum (around 460 

nanometers). Indoor lightning has 

been traditionally “warmer,” or 

towards the yellow, longer-wave-

length end (about 555nm) or red at 

the far end (650nm). That’s true of 

fire and most incandescent lighting.

But a shift in lighting over decades 

has shifted towards cool, “white,” or 

“daylight” illumination, whether 

incandescent, fluorescent, or LED. 

While thought of as whiter, they 

actually produce bluer light, resem-

bling more closely our perception of 

a sunlit day.

This description of color gets 

labeled color temperature, and is 

measured in kelvins (K). On one end 

of the spectrum, you have red/yellow 

candlelight at 1,000K, considered 

very warm; at the other end, pure blue 

sky is 10,000K, considered very cool.

Most LCD monitors and mobile 

displays can calibrate against a 

standard called D65, which centers 

at 6,500K, fairly blue and fairly 

cool—it’s described as outdoor 

daylight at noon. Many displays are 

tuned or default to a higher tempera-

ture, though, and are much bluer.

Specific research and reasonable 

speculation centers around how 

predominantly blue light from 

television sets, computer monitors, 

laptop displays, and mobile screens 

might be connected 

with the increase of a 

host of ailments in 

nations in which a 

large percentage of 

residents use those 

technologies before 

and at bedtime.

Of special interest 

is the simple lack of 

sleep. The CDC 

estimates (cdc.gov/

features/dssleep) 50 

to 70 million U.S. 

adults have disorders 

that prevent them 

from sleeping sufficiently to be alert, 

productive, and rested on an aver-

age day.

All the discussion of blue light has 

led to programs and extensions for 

many computer platforms that attempt 

to reduce the production of blue light 

in order to avert circadian rhythm 

disruption. The f.lux software ( just 

getflux.com) is a well-known example, 

available for OS X, Windows, Linux, 

and rooted Android phones. (It could 

be installed through a workaround in 

iOS, until Apple asked f.lux to stop 

distributing it.)

iOS’s Night Shift is just the latest 

entrant for color-temperature shifting, 

albeit making it available to roughly 

THE CDC 
ESTIMATES 50 TO 
70 MILLION U.S. 
ADULTS HAVE 
DISORDERS THAT 
PREVENT THEM 
FROM SLEEPING 
SUFFICIENTLY 
TO BE ALERT, 
PRODUCTIVE, 
AND RESTED ON 
AN AVERAGE DAY.
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500 million devices via iOS 9.3. Only 

devices released starting in about 

2013 have hardware that supports 

the feature, according to Apple’s 

feature notes.

But the big problem is that there’s 

no solid evidence that mobile 

screens’ color temperature is the real 

culprit, nor whether devices and 

monitors can shift enough to matter if 

they were—or even if blue light on its 

own is the trigger.

BLUE MEANINGS

While exposure to colors of light has 

been well researched, it’s not entirely 

clear that merely seeing light heavy 

in the blue part of the rainbow is the 

trigger—or at least the sole trigger. It 

may be that a shift in color in the 

hours around twilight (go.macworld.

com/shiftincolor), which comes with a 

change from blue to yellow, could be 

a more significant marker. Blue may 

be a red herring.

It might also be the intensity of 

light or the proportion of the visual 

field it occupies. A large, bright 

screen that’s far away could have as 

little or the same effect as a small, 

bright screen close up. Many of the 

studies until recently used full-room 

illumination or specifically-tuned light 

sources (like panels used to treat 

seasonal affective disorder), and 

have taken place in highly controlled 

laboratory environments that block 

all other light. Because of the cost 

and complexity of the experiments, 

the most rigidly constructed ones 

often involve only a dozen or so 

individuals who spend several days 

under observation.

In terms of size and brightness, it’s 

more likely that an effect on melato-

nin production would come from 

adjusting an iPad Pro than an iPhone 

of any size, due to light and intensity 

of light produced.

Mariana G. Figueiro, a professor at 

Rensselaer Polytechnic Institute and 

the program director of its Lighting 

Research Center (www.lrc.rpi.edu), 

says her group has used precise 

measurements of light sources and 

displays to calculate predicted 

effects and performed clinical testing 

to test outcomes.

She notes there’s a huge variation 

between an iPhone, a tablet, and 

large-screen televisions. “People 

tend to have a misconception that 

because it looks bright, because your 

visual system is so sensitive, that it is 

affecting your melatonin,” she says. 

Her work and that of others has 

shown that you “can still suppress 

melatonin with a warm color if it’s a 

high light level.”

Even what’s being displayed 

matters. Dr. Figueiro says a Face-

book page with a white background 

and mostly text produces more light 

than the same page viewed with 

iOS CENTRAL iOS 9.3: NIGHT SHIFT

56

http://www.softgozar.com


white on black text.

Although she hasn’t tested Night 

Shift yet, she says that in terms of 

size and brightness, it’s more likely 

that an effect on melatonin produc-

tion would come from adjusting an 

iPad Pro than an iPhone of any size, 

due to light and intensity of light 

produced.

But beyond the variation, there’s 

the degree of blue removal. Ray 

Soneira, the president of Display-

Mate, a company that makes video-

diagnostic hardware and software, 

says that Night Shift and related 

software doesn’t turn down blue 

spectra in the correct range enough, 

thus not providing assistance even if 

true.

Via email, Dr. Soneira explains that 

he feels there’s a paucity of “under-

standing of displays, light spectra, or 

human color vision” among many 

researchers in the field that’s leading 

to a mismatch in what’s being tested 

and conclusions reached. As a result, 

those studies are influencing system 

design without a firm grounding.

In the case of Night Shift and 

similar systems, he argues that the 

blue component would need to be 

entirely removed or reduced signifi-

cantly more than the systems offer, 

which in turn would make the display 

too yellow for most people. He 

writes, “Just slightly reducing the 

blue, which is what most apps do, 

won’t accomplish much, so the 

improvements people experience 

are often mostly due to placebo and 

their own con-

scious modifica-

tion of their 

behavior in using 

displays.”

In any case, Dr. 

Figueiro says 

sleep research 

shows there’s an 

extremely important and often 

overlooked factor that requires more 

discipline than an automatic color-

temperature adjustment. “Disruption 

of sleep is not just melatonin sup-

pression; it’s what you’re doing to 

your brain to keep it alert,” she says. 

She recommends turning off all your 

screens two hours before going to 

bed. “These programs help, but they 

don’t completely remove the possi-

bility of suppressing melatonin.”

But she’s not disregarding color as 

a factor. Instead of focusing on 

screens, her group is working on an 

app that would gather information 

about your light exposure across a 

day and make recommendations 

about the best times to get the right 

light. With remote-controlled, color-

variable bulbs from Hue and others, 

she suggests a future in which this 

app could change overall lighting to 

fit your needs, and, just maybe, have 

a real impact on your sleep. ■

DR. FIGUEIRO 
SUGGESTS TURNING 
OFF ALL SCREENS 
TWO HOURS BEFORE 
GOING TO BED.
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5 of the best Google apps for iOS, 
and how to use them
Not all Google geeks use Android. Bring popular productivity tools to your 
iPhone or iPad with these native versions of your favorite apps.

BY MICHAEL ANSALDO

iOS CENTRAL
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B
eing an Apple aficionado doesn’t mean you have to 
suppress your Google-geek streak. Google has made 
many of its popular productivity apps available for iOS,  

so it’s not hard to design your own Android-esque ecosystem 
(go.macworld.com/dyo-android) on your iPhone or iPad. Here are 
the five you should start with.

GMAIL

Gmail (go.macworld.com/gmailapp) 

has more than 900 million users (go.

macworld.com/900mgmail), and 

chances are you’re one of them. If so, 

you know that Apple’s mail app doesn’t 

always play nice with Gmail’s push 

feature. A few third-party alternatives 

promise to smooth out the relationship, 

but the easiest way to avoid it is to use 

the official Gmail app.

The app brings the best of Gmail’s 

features to your iPhone or iPad, 

including multiple-account support, 

instant push notifications, threaded 

conversations, and its renowned 

search capabilities. And archiving, 

labeling, and deleting is a lot more 

straightforward than in the swipe-

centric mail app.

GOOGLE

You’re already using Google for all 

your web searches. Download the 

talk-instead-of-type app, and you 

won’t have to be envious of your 

Android friends anymore (we know 

you are). Just say “OK Google” to 

find out where the nearest dry 

cleaner is or to find out what time 

your favorite team is playing tonight. 

Even better, the Google app (go.

macworld.com/googleapp) can help 

you with your productivity by remind-

ing you to call a client or providing 

the status of your flight. Siri has some 

competition. 

FOR THE MOST 

seamless Gmail 

experience on iOS, 

use the official app.
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GOOGLE CALENDAR

The native iOS calendar will sync 

with your Google account, but the 

experience is much better with the 

official Google Calendar app (go.

macworld.com/googlecalapp). The 

app’s default schedule view presents 

the days in a chronological scroll, 

which feels much more natural 

thanks to the many social feeds we 

thumb through regularly. If you don’t 

like that, you can opt for one-day, 

three-day, or week-long views. Its 

best trick, of course, is automatically 

detecting events and appointments 

in your Gmail account and adding 

them to your docket.

GOOGLE KEEP

Apple’s stock Notes app has come a 

long way from its days as a digital 

notepad. Recent updates added 

more text formatting options, check-

list creation, the ability to insert 

attachments into notes, and pass-

word protection (go.macworld.com/

pwprotection).

Google Keep (go.macworld.com/

googlekeepapp), however, remains 

the more mature note-taking app. It 

has all of the above features, plus 

scanning capabilities, OCR, and 

time- and location-based reminders. 

It also supports voice-dictated notes, 

an essential feature for capturing 

inspiration on the fly.

GOOGLE AUTHENTICATOR

Two-factor authentication adds a 

layer of security to your login by 

requiring information in addition to 

your password. In the case of your 

Google account, it requires a one-

time verification code, which this app 

generates. Once you configure 

Google Authenticator (go.macworld.

com/googleauth), it will supply the 

code even without a network or 

cellular connection. It also supports 

multiple accounts. ■

iOS CENTRAL BEST GOOGLE APPS FOR iOS

GOOGLE CALENDAR presents events in a familiar 

chronological scroll.
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It takes all of us to beat cancer. 

Doctors, researchers, volunteers, 

and most importantly, people like 

you. Join the movement to beat 

cancer at StandUp2Cancer.org
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SHOPPING LIST APP

ANYLIST: GROCERY APP CROSSES 

OFF NEARLY EVERYTHING ON 

OUR SHOPPING LIST
BY J.R. BOOKWALTER

ALTHOUGH MY WIFE LOVES TO BROWSE on her iPhone and iPad, 

she’s old-fashioned when it comes to shopping. Planning weekly meals 

or making a grocery list is all about pen and paper, no matter how 

much I try to infuse software into the mix. But her traditional ways may 

not be long for this world.

iOS CENTRAL

ANYLIST 5.2

mmmm
AT A GLANCE

AnyList is a full-featured 

grocery shopping list and 

recipe organizer with 

lightning-fast cloud sync and 

cross-platform support.

PROS

•  Cross-platform grocery 

shopping list and recipe 

manager

•  Insanely fast cloud sync

•  Easy sharing of lists, recipes

CONS

•  No Apple Watch support

•  Mac, web apps require 

annual paid subscription

•  Limited database support 

for department or drug 

stores

PRICE

Free; in-app purchases 

available

COMPANY

Purple Cover Inc.

iOS CENTRAL

Reviews

iOS CENTRAL
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ATTENTION SHOPPERS!

AnyList (anylistapp.com) is a free, universal grocery shopping app 

offering a built-in database of items for creating multiple lists. Start 

typing the name of an item, and the app autocompletes each entry to 

speed up the process. You can even add items by voice with Siri, thanks 

to a clever feature that checks Reminders for 

new items at launch, then removes them once 

imported.

Once an item is in your cart, tap to cross it 

off the list; another tap restores it for next 

time. Added items are automatically sepa-

rated into categories, but can be manually 

sorted into custom groups. You can mark 

items as favorites, move or copy between 

lists, and assign color themes.

AnyList also stores entire recipes, either 

manually entered or copied and pasted from 

websites or email. With a single tap, all 

required ingredients are added to a shopping 

list, or the complete recipe can be printed or 

shared via email.

Recipes and individual lists can be shared 

with others, such as your spouse, roommates, 

or the entire family. All that’s required is an 

email address, used to sign up for a free 

account. Everything is securely backed up in 

the cloud, with freaky fast sync between 

devices.

BUFFET OF FEATURES

While the free version offers an impressive 

array of features, a paid subscription ($8 for a 

single user or $12 for a family per year) really 

makes AnyList boil. For starters, paid users 

are able to access accounts from any web browser, or use companion 

native applications for Mac and Windows.

Subscribing also adds browser extension support for automatically 

ITEMS CAN BE checked off your 

list as they’re purchased with 

a tap, and restored for next 

time the same way.
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REVIEWS  |  ANYLIST 5.2iOS CENTRAL

importing recipes from popular websites with a click. This feature 

worked like a charm on SkinnyTaste, The Cozy Apron, Allrecipes, and 

countless others, breaking down a list of ingredients and preparation 

steps with a photo of the completed dish. On rare occasions where 

websites weren’t formatted to microdata or hRecipe standards, it was a 

trivial matter to copy and paste data into the Mac app, which parses an 

entire block of text into individual steps.

Paid members can also add photos to items, scale recipe ingredient 

quantities, assign stores to lists, personalize with premium themes, and 

organize lists into folders. There’s even an option to set up location-

based reminders, which trigger when you’re near a favorite store, but it 

would be nice if this worked only for lists with unpurchased items.

Although AnyList can be used to keep track of any kind of list, it’s 

ANYLIST IS ALSO a depository 

for all your favorite recipes, 

and ingredients can be 

added to a shopping list in 

one tap.
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best suited to grocery stores; I’d love to see more categories and 

common items from department and drug stores added to the mix. 

There’s also no companion Apple Watch app, which would make check-

ing off items as they’re purchased even more convenient.

BOTTOM LINE

AnyList checks off just about everything you could want in a grocery 

shopping app, but works best with a paid subscription. ■

AN ANNUAL PAID subscription 

also adds native Mac and PC 

applications to the mix for 

planning shopping trips from 

the desktop.

65

http://www.softgozar.com


TEXT EDITOR

ULYSSES FOR iPHONE: ANYTHING 

BUT A PLAIN TEXT EDITOR
BY MICHAEL SIMON

EVEN BACK WHEN the only way 

to write on the iPhone was on a 

skeuomorphic notepad, it was 

clear that Apple’s revolutionary 

handset was a productivity 

dynamo. Marker Felt aside, and 

after just a few minutes with 

Notes (go.mac world.com/

notesios9), it wasn’t hard to 

envision a day when a multitude 

of writing apps would be avail-

able to store, save, and share 

your thoughts.

But I’m not sure even Steve 

Jobs could have imagined an app 

like Ulysses (ulyssesapp.com). 

Already one of the best text 

editors on the Mac, Ulysses has 

always lived up its powerful 

pedigree, with first-class organi-

zation, excellent Markdown 

support and a smart, sophisticated interface that’s as adept as it is 

adaptable. When it came to the iPad last year it brought the same 

writing and editing experience to iOS, expertly tailoring the mouse-

centric experience for touch without losing any of its functionality.

But while the iPad is a natural fit for an app like Ulysses, the iPhone 

is a trickier proposition. For most full-featured text editors, the iPhone 

app is a companion, sacrificing features for the sake of an uncluttered 

workspace. In fact, The Soulmen’s previous iPhone effort, Daedalus 

Touch (daedalusapp.com), was just that: a lesser, retooled Ulysses 

sidekick designed for simple, on-the-go note-taking.

REVIEWSiOS CENTRAL

ULYSSES FOR 

iPHONE

mmmmm
PRICE

$20 introductory price;  

$25 regular price

COMPANY

The Soulmen

REVIEWSiOS CENTRAL
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Ulysses for iPhone (go.macworld.

com/ulyssesapp) is anything but 

watered-down. The universal app is 

only a companion in the sense that it 

syncs documents edited on other 

devices, but it works as well as a 

standalone app as it does as part of 

the larger suite (which now also 

includes an iPad Pro version). With 

an interface equally suited for 

long-form pieces and short notes, 

nothing about it feels underpowered 

or crippled; if anything it might be 

the first text editor that successfully 

brings desktop-level performance to 

a 5-inch screen.

Users of the Mac or iPad version 

of Ulysses will instantly be familiar 

with its multi-paned layout of groups 

and sheets, but the placement of 

buttons and menus have been 

carefully considered for the smaller 

screen. For example, you’ll always 

find the symbol to create a new 

group or new document at the 

bottom of the screen, making it 

easier to reach with your thumb. And 

panels can be navigated simply by 

swiping from the edge of the screen, 

also helping with one-handed use.

EASY WRITER

But no matter how you hold your 

phone, Ulysses will deliver a near-perfect writing experience. Its inter-

face is minimal for sure, but you won’t have to hunt to find expert 

features like Markdown shortcuts, special characters and an in-docu-

ment search bar, thanks to a refined button bar that puts a host of 
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options at your fingertips without a hint of clutter or confusion. Hide the 

keyboard and you’ll see a word/character count, but you can’t use it to 

get stats within a selection of text, a feature that’s useful in 1Writer 

(1writerapp.com) and Pages (apple.

com/ios/pages).

Swiping left on the editing window 

brings up the attachments pane, 

where you can add keyword filters, 

set goals, take notes, and attach 

images, power-user features that 

make Ulysses feel more like a 

miniature OS X app than an iOS one. 

And you can customize it with a dark 

mode or one of four tasteful themes, 

with many more available for down-

load in the Ulysses Style Exchange 

(though you’ll need the Mac app to 

install them).

iCloud keeps documents con-

stantly synced across all three 

platforms, and you can import files 

from Dropbox, One Drive Google 

Drive and a variety of other loca-

tions. Those concerned about the 

reliability of Apple’s servers can rest 

their minds; Ulysses for iPhone 

utilizes the same local backup 

system as the Mac and iPad ver-

sions, letting you browse previous 

versions in the event a document 

reverts to an outdated version 

(which happened once or twice 

during testing). Exporting is no 

slouch either, with settings for HTML, 

ePub, Medium, and DOCX.

Ulysses is the first text editor that 

truly seems built for the iPhone 6. It 

REVIEWS  |  ULYSSES FOR iPHONEiOS CENTRAL
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doesn’t need the big screen to 

operate—and surely iPhone 5 users 

won’t regret the purchase—but 

Ulysses is right at home on the 

4.7- and 5.5-inch models (and takes 

full advantage of the S’s 3D Touch as 

well). Dedicated users of the iPad 

app will no doubt find themselves 

reaching for their tablets far less 

often, and won’t freak out if they 

forget to pack it. Ulysses is the text 

editor iPhone users have wanted for 

years, and like the rest of the suite, it 

was well worth the wait.

BOTTOM LINE

Everything that makes Ulysses great 

on the Mac is concentrated in the 

exquisite iPhone version, so much 

so that you might actually prefer 

writing on a five-inch screen. ■
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iOS CENTRAL

What’s new  
at the App Store

COMPOSER’S 
SKETCHPAD
We missed the $3 Composer’s Sketch-

pad (composerssketchpad.com) when 

it first launched, so the latest update is 

a chance to correct that oversight. The 

app lets you jot down musical ideas 

with your finger—or Apple Pencil, if 

you have an iPad Pro—and hear them 

played back using 100 instruments 

and a percussion set. (Check out this 

trailer: go.macworld.com/composer-

sketchpadtrailer.) The update includes 

support for multitasking, portrait mode, 

and other bug fixes.

MLB Manager 2016
Ever want to play video sports 

games, but without all the button-

pushing and quick reactions they 

usually require? The $5 MLB 

Manager 2016 (go.macworld.com/mlbmgr2016) 

lets you sit back and coach—either take an 

existing team and guide it through a season, 

create your own fictional club to test out match-

ups, or choose a historic team (from 1919, 1939, or 

2012)—to play with. (Additional seasons are 

available for $1 apiece.)

Divvio
The free Divvio (go.macworld.com/

divvio) app lets friends (natch) divvy 

up bills by tracking group expenses, 

as well as who paid whom for what. It’s ideal for 

outings, or for tracking bills with your room-

mates.

parkOmator
parkOmator (go.macworld.com/

parkomator) remembers where 

you park, how long you have left 

on your meter, and, when it’s time to return to 

your car, tells you the fastest route back. The 

$2 app includes Apple Watch support.

Shapr3D
Shapr3D (go.macworld.com/

shapr3d) is “a quick but precise 

way to create 3D models for 

engineering, design, 3D prints, and 

more.” Use your Apple Pencil, and developers 

say the app works as a “state-of-the art 

modeler.” Even with just your trusty fingers, the 

app lets you “explore modeling work on the fly.”  

—JOEL MATHIS
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iOS CENTRAL

BY JOEL MATHIS 

Keeping it wireless
This month’s roundup features a house monitor that alerts your phone, a mobile EKG 
monitor on your phone, and an amplifier to get the best sound out of your Apple TV. 
Plus a smart bluetooth adapter and a tablet table.  

TAP NUMBERS TO 

VIEW PRODUCTS.  

TAP WEBSITE URLs 

FOR MORE INFO.

SMART BEAN  
The $30 Smart Bean (antecmobileproducts.

com) is a Bluetooth adapter—enabling 

wireless functionality on wired headphones, 

speakers, and more. It has a range of up to 

30 feet and offers up to eight hours of music 

playback on a single charge. 

WITHINGS HOME
The $190 Wi-Fi Security Camera with 

Air Quality Sensors (withings.com) is 

an app-enabled device—monitor it 

from your iPhone!—that offers HD 

video, two-way audio, a 135-degree 

wide angle, and night vision 

capabilities.
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iOS CENTRAL

Keeping it wireless

KARDIA MOBILE
The $99 Kardia Mobile EKG (alivecor.com) 

“allows you to capture a medical-grade 

EKG in just 30-seconds.” Keep a record of 

information for personal insights, or relay it 

to a doctor for immediate guidance.

IN-HABIT  
The $99 In-Habit amplifier for Apple 

TV (intonationaudio.com) is built to 

compliment your second- or 

third-generation Apple TV; the device 

provides an optical input, two 3.5mm 

stereo jacks, and Bluetooth 

connectivity for streaming audio from 

your iPhone or iPad. 
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NOMAD
The €310 Nomad tablet 

table (spell-online.com) 

is basically an end table 

meant to feature your 

iPad. The frame is 

made of powder 

coated steel; the 

tabletop tablet insert  

is made of walnut or 

oak and finished in 

trans lucent oil. It comes 

in a half-dozen colors.

LUNA
The $129 Luna (crazybaby.com) is billed as 

the “perfect integration of sound, light, and 

appearance,” made with an aircraft-grade 

aluminum skeleton which houses a 2-inch 

full range NdFeB speaker—you’ll get some 

deep bass from this—and featuring the 

“Luna eye,” a light that changes colors and 

patterns according to your preferences 

and the music. Using MESHNET network 

technology, up to 32 units can be paired 

together, creating a music network.
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You don’t need to spend more on the 
12.9-inch iPad Pro—the smaller model is a 
better size and isn’t hampered by having 
half the RAM. By Susie Ochs

9.7-INCH  
iPAD PRO REVIEW:

HITS THE SWEET SPOT 
BETWEEN SIZE AND PRICE

FEATURE
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VIDEO: 
9.7-INCH 
iPAD PRO
Go ahead, save 

a couple hun 

dred bucks by 

picking the 9.7- 

inch iPad Pro 

over the 12.9- 

inch model (go.

macworld.com/

ipadpro97vid).

Internet connection 
required.

A  
funny thing happened while I was reviewing 

the 9.7-inch iPad Pro (apple.com/ipad-pro). I 

forgot my computer at home and only 

brought the iPad to work. This wasn’t inten-

tional. I’m not doing the “Can the iPad Pro replace my 

laptop?” challenge. I tried that (apple.com/ipad-pro) briefly 

with the 12.9-inch iPad Pro, and didn’t have the best 

results, constantly running into annoying little roadblocks 

and workarounds that slowed down my workflow.

The reason I didn’t notice that my laptop wasn’t in my 

backpack that morning is simple: I’m carrying two iPads 

right now, both the 9.7-inch iPad Pro and its big old 12.9-

inch sibling, and the larger iPad Pro is almost as big as  

my laptop.

LIL PRO IS EXACTLY 

the same size as the 

iPad Air 2—most cases 

should fit, but old cases 

might obstruct the new 

iPad’s extra speakers. 
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Apple 9.7-inch 
iPad Pro

mmmmh
AT A GLANCE

The 9.7-inch iPad Pro 
is more portable and 
takes better video 
than the bigger iPad 
Pro. It adjusts your 
screen’s color 
temperature to match 
your surroundings, 
and generally does 
everything the bigger 
iPad Pro can do, only 
for less money.

PROS

•  Weighs under a 
pound, and smaller 
size is easier to use 
away from a table

•  Supports Apple 
Pencil

•  Shoots 4K video

CONS

•  Less RAM than  
the bigger version,  
but real-world 
per form ance is 
barely affected

PRICE

Wi-Fi only: $599 for 
32GB storage; $749 
for 128GB; $899 for 
128GB. Add $130 for 
cellular.

COMPANY

Apple

Yes, at 1.5 pounds, the big iPad Pro 

is lighter than my 2.4-pound 13-inch 

MacBook Air, but I didn’t feel those 

missing ounces in the context of the 

rest of the junk in my bag, and the 

footprint of the big iPad versus my 

laptop is nearly the same. I find the 

big iPad Pro unwieldy—I’d rather just 

bring my computer, thanks—but the 

new 9.7-inch version (starting at 

$599 at the Apple Store, go.mac-

world.com/buy97ipad) is sized just 

right, and with nearly all the power, 

it’s definitely the iPad for me. (And, 

no, I didn’t notice the difference in 

RAM, but more about that later.)

Size matters
Even though the 12.9-inch iPad Pro is 

the most powerful iPad I’ve ever 

used, after I was done reviewing it, I 

didn’t take it anywhere. Most of the 

time, it just sat on my desk. The 

9.7-inch iPad Pro (can we call them Lil 

Pro and Big Pro, please?) is sized like 

an iPad Air 2, and it weighs just a hair 

under a pound. Like the iPad mini 

and iPad Air 2 before it, the Lil Pro 

seems to disappear into my bag, and 

I don’t mind taking it everywhere, 

much to the delight of my iPad-loving 

4-year-old son.

One of the advantages of the Big 

Pro’s screen size is that it gives you 

plenty of room to run two apps side 

by side in iOS 9’s split-screen mode. 

Even with less real estate, side-by-

side works great on the Lil Pro, too. 

With the Big Pro’s 2732x2048 

display, each app’s half of the screen 

THE SMART KEYBOARD 

isn’t my favorite to 

type on, but I do like 

it as a slim protective 

cover, and its 

magnetic attachment 

is more convenient 

than a full case.

FEATURE     RE V I E W: 9 .7- I NCH iPA D PRO
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winds up being almost as big as the 

2048x1536 Lil Pro held in portrait 

mode. But half of the Lil Pro’s screen 

still winds up being enough space to 

work in, even as you use text-heavy 

apps like Mail and Safari.

I see a lot more webpages (includ-

ing Macworld.com and even Apple 

.com) default to tablet or mobile 

views in split-screen Safari, even 

though they load as the full-size 

version when Safari has the entire 

screen. That’s not a big deal, and 

even helps readability. Both sides of 

the screen stay active in split-screen 

mode—I was able to play a Macworld 

video in Safari on one half of my 

screen while writing this review in 

Byword on the other half.

True Tone
The Lil Pro has one feature its big 

brother doesn’t, True Tone. This 

feature is enabled by a new ambient 

light sensor embedded in the Lil 

Pro’s display. Every iOS device has 

these ambient light sensors, which 

enable the Auto Brightness feature, 

but in the new Lil Pro, those sensors 

measure the color temperature of 

the light in the room, not just its 

intensity. That way, iOS can adjust 

the color temperature of your display, 

in an attempt to match it up, so your 

display doesn’t look more blue in 

some light and more yellow in others.

You can turn this off in System 

Preferences → Display, but it’s a 

binary on/off switch. There’s no slider 

THIS SCREEN IS way 

too nice to yellow it 

up by layering True 

Tone and Night Shift 

together. 
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to lessen the intensity of the effect—

the whole idea is that it’s automati-

cally adjusted. The new Night Shift 

feature in iOS 9.3 (go.macworld.com/

ios93), on the other hand, isn’t 

controlled by sensors, so it does have 

a slider to let you adjust the intensity. 

(I can’t stand it at any more than about 

25 percent, but your mileage may 

vary.) Night Shift isn’t aimed at 

matching the color temperature of the 

room; rather it just shifts the tempera-

ture of your screen from blue to 

yellow at night, in case the reduced 

blue light helps you sleep better—

although the research isn’t so conclu-

sive (see page 52, “The new Night 

Shift”) that this particular feature 

would help. You can use both Night 

Shift and True Tone together on this 

Lil Pro, but it looks terrible, like your 

screen was suddenly submerged in a 

bucket of apple juice.

I remain ambivalent about True 

Tone. I don’t mind keeping it on, but I 

wish I could tone it down just a tiny 

bit. Still, after a couple of days I 

stopped noticing it, until I had the Lil 

Pro side by side with a MacBook, and 

the MacBook screen’s blueish tint was 

more visible than ever. Anyone who 

does get hooked on True Tone may 

start jonesing for it on all their 

devices, and I wouldn’t be surprised if 

Apple starts building these new light 

sensors into more screens. In the 

meantime, there’s always f.lux ( just-

getflux.com) on the Mac.

THE CAMERA 

PROTRUDES just a bit, 

but the Lil Pro has a 

flash, for the first time 

on an iPad. (The iPad 

here is shown with 

the Smart Keyboard 

cover.)

FEATURE     RE V I E W: 9 .7- I NCH iPA D PRO
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Pro features at  
a value price
The Lil Pro joins the Big Pro in 

supporting the Apple Pencil (go.

macworld.com/applepencilrev), which 

remains just delightful. In fact, it’s 

even more so now, just because 

more apps support it. I like drawing 

and coloring with the Pencil to relax, 

but I’m even taking more meeting 

notes with it lately, too, just because 

the “infinite scroll” writing feature in 

GoodNotes 4 (go.macworld.com/

GoodNotes4) is so fun. The Pencil is 

also better with the Lil Pro because 

it’s easier to hold the smaller iPad in 

one hand while you draw or write 

with the other. With the Big Pro, I felt 

like I had to be seated, preferably at 

a table, when I was going to do 

anything with the Pencil.

It’s also worth pointing out that the 

Lil Pro starts at $200 cheaper than 

the Big Pro, and the Pencil is $99. 

The Lil Pro’s Smart Keyboard is $20 

less too, at $149, compared to $169 

for the Big Pro’s Smart Keyboard. So 

a full setup of a 32GB Wi-Fi-only iPad 

Pro, Smart Keyboard, and Pencil is 

$847 if you choose the smaller iPad 

Pro, and $1,067 if you choose the 

larger version.

Oh, and if you use Microsoft Office, 

there’s another bit of potential cost 

savings from choosing the smaller 

iPad. Microsoft requires an Office 

365 subscription if you want to 

create Office documents on a tablet 

larger than 10.1 inches—so that rule 

applies to the 

Big Pro but not 

the Lil Pro (go.

macworld.com/

officeontablets). 

If you don’t 

already have 

Office 365 for 

your Mac, you 

could save $7 

per month or 

$70 per year (the 

price of Office 

365 Personal) by 

avoiding buying it for your iPad Pro.

The smaller Smart Keyboard 

provides almost the same typing 

experience as the Smart Keyboard 

made for the Big Pro. It has all the 

same keys in exactly the same 

THE PENCIL IS ALSO 
BETTER WITH THE 
LIL PRO BECAUSE 
IT’S EASIER TO HOLD 
THE SMALLER iPAD 
IN ONE HAND WHILE 
YOU DRAW OR 
WRITE WITH THE 
OTHER. 
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places; they’re just a little smaller. 

Both keyboards have a spill-resistant 

fabric coating and low-travel keys 

that I can’t seem to type on without 

slamming my fingers down as hard as 

possible. (It’s like my fingers don’t 

believe the short-travel keys are 

really going down, and I formally 

apologize to every coworker who has 

discreetly slid on his or her head-

phones when I start up with my 

infernal key-pounding again.)

I really appreciate the extra 

speaker power on both iPad Pro 

models, since I watch a lot of stream-

ing movies and TV on my iPads. The 

four speakers provide enough 

oomph for an action movie, and 

make music and podcasts sound 

better when you’re listening without 

headphones too.

The iSight camera on the Lil Pro is 

even better than the Big Pro’s camera, 

because it has a True Tone flash and 

supports Live Photos, which the Big 

Pro doesn’t. Plus, it records 4K video, 

FEATURE     RE V I E W: 9 .7- I NCH iPA D PRO
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while the Big Pro is stuck on 1080p. 

Want to shoot slo-mo? The Lil Pro lets 

you choose 1080p at 120fps or 720p 

at 240fps, while the Big Pro can only 

handle 720p at 120fps. Again, the Lil 

Pro’s physical size makes me more 

likely to use it to shoot stills or video, 

and even if you scoff at the very idea, 

don’t forget that plenty of apps use 

the cameras for things like augmented 

reality or even…well, shooting video. 

For example, an app called Hudl 

Technique (hudl.com/products/

technique) lets you film a baseball, 

tennis, or golf swing and then analyze 

it in slo-mo for proper form and 

technique. It’s universal for the iPhone 

and iPad, but the iPad’s bigger screen 

makes it a lot easier to use, and the 

camera captures enough detail that 

you can zoom way in on a wrist or an 

ankle turn during a swing.

What about the RAM?
It’s true that the Lil Pro has 2GB of 

RAM, or half the RAM of the Big Pro, 

which has 4GB. But bigger screens 

demand more resources to power 

them, and in testing with GeekBench 

3, the Big Pro only scored about 6 

percent better overall, so I don’t think 

many people will notice a perfor-

mance hit in most tasks. Memory-

specific tests show more of a discrep-

ancy, because as it turns out, it’s not 

just the amount of RAM that’s differ-

OH YEAH, and as of 

right now, this is 

the only iPad that 

comes in Rose 

Gold. 
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ent, but the memory bandwidth too.

In Geekbench 3’s multicore mem-

ory benchmark, the Big Pro scored 

4112. On the Lil Pro, the same test 

produced 3203, or about 28 percent 

worse. In most tasks, you’re unlikely 

to see the impact of a little less 

memory bandwidth. Where it’s more 

likely to manifest itself is graphics-

related tasks such as gaming.

In 3DMark’s Sling Shot Extreme 

test, for example, the Lil Pro scored 

3146, about 20 percent worse than 

the Big Pro’s score of 3787. But when 

the same test was set to render 

offscreen, the Big Pro’s 3794 only 

bested the Little Pro’s 3528 by 7.5 

percent. And in the AnTuTu Bench-

mark app, the Lil Pro scored just 11 

percent worse than the Big Pro.

As a matter of policy, Apple 

doesn’t get into the weeds on its 

choices for the amount of RAM or 

how it’s configured. It could be that 

Apple selected slightly lower-speed 

RAM for the Lil Pro to save on power 

since the smaller unit has a smaller 

battery. Also, the smaller screen has 

a lower resolution, and Apple may 

have decided it didn’t need the 

highest performance RAM.

For the most part, the amount of 

RAM is probably nothing to lose 

sleep over. There’s nary a perfor-

mance difference in the computing 

side of things and even on graphics 

tasks, when you consider the resolu-

tion, the difference 

is pretty small, as 

well. When buying 

a Mac with con-

figurable RAM, I 

tend to max it out 

at purchase as a 

way of “future 

proofing” the 

machine, hoping 

that the more RAM 

I have, the longer 

that Mac will last 

before it feels 

obsolete. If you 

can’t stand the 

thought of buying 

an iPad with half 

the maximum RAM 

available, you could shell out an 

extra $200 for the Big Pro, or wait to 

see what Apple does with these 

iPads next year. But for me, the 

9.7-inch iPad Pro’s performance is 

worth its price and then some.

Bottom line
If you’re using an iPad Air or older, 

the 9.7-inch iPad Pro is a worthy 

upgrade. If you’re trying to decide 

between a 12.9-inch iPad Pro and the 

smaller version, I’d go small because 

it’s a more convenient size, and the 

$200 price difference is worth the 

minimal decrease in performance, 

especially if you plan to spend that 

difference on Apple’s accessories. ■
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IF YOU’RE USING 
AN iPAD AIR OR 
OLDER, THE 9.7-
INCH iPAD PRO IS A 
WORTHY UPGRADE.
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 REVIEWED: 

iPHONE SE
IT’S A POCKET-SIZE POWERHOUSE

GOOD NEWS FOR 

FANS OF SMALL 

PHONES: APPLE 

DIDN’T MAKE THE 

4-INCH iPHONE SE 

A SECOND-CLASS 

DEVICE.
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T
he SE is the little iPhone that 

could. With a 4-inch screen 

and the body of an iPhone 

5s, it fits in my pockets 

better than my iPhone 6s, and it’s 

easier to use one-handed. But it 

doesn’t compromise much over its 

bigger, more expensive siblings.

If you were waiting for Apple to put 

out another 4-inch phone before you’d 

upgrade, you’re probably dancing in 

the streets right now—and you should 

be, because this phone is such a huge 

step up from the iPhone 5s. If you’re on 

the fence between the iPhone SE 

(apple.com/iphone-se) and the flagship 

iPhone 6s (go.

macworld.com/

iphone6sreview), 

the SE’s lower 

price (starting at 

$399 at the 

Apple Store, go.

macworld.com/

buyse) might 

sway you to the 

smaller screen, 

especially 

because the SE 

delivers nearly as 

much perfor-

mance.

iPHONE SE

mmmmh
AT A GLANCE

For anyone who’s been 
holding out for a smaller 
iPhone, the 4-inch iPhone 
SE is worth the wait.

PROS

•  Easier to hold and use 
one-handed

•  Great camera

CONS

• No 3D Touch

PRICE WHEN RATED

$399 for 16GB of  
storage; $499 for 64GB

COMPANY

Apple
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DEJA VU DESIGN
In his hands-on (go.macworld.com/

iphonese1st), Jason Snell called the 

iPhone SE a flashback to the iPhone 5 

and 5s, and he’s entirely right. Apple 

points out the “matte-chamfered 

edges” (the iPhone 5s’s chamfers 

were, um, less matte, I think?) and 

“color-matched stainless steel inset 

Apple logo” (meaning the logo is a 

separate piece of inlaid metal and not 

merely stamped on), but that’s just 

marketing. If a friend asks about your 

iPhone SE and you triumphantly show 

off its matte-chamfered edges, you 

probably deserve the eye-roll you’re 

about to get.

What is important, then? Apple 

didn’t move any of the buttons, so 

you can still use cases built for the 

iPhone 5 and 5s. The rear-facing 

iSight camera sits flush with the back 

of the phone, unlike the slightly 

protruding camera that the larger 

iPhones have been plagued with 

since the iPhone 6. And the SE’s flat 

edges let you stand it up on its side, 

in case you want to take a photo or 

MMM, so matte-  

chamfered!

FEATURE     RE V I E W ED: i PHON E SE

PHOTOGRAPH BY ADAM PATRICK MURRAY

APPLE DIDN’T  
MOVE ANY OF THE  
BUTTONS, SO YOU CAN  
STILL USE CASES BUILT FOR 
THE iPHONE 5 AND 5S. 
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watch a video and you don’t have a 

proper iPhone stand.

The Touch ID button on the iPhone 

SE is the “first generation” version 

from the iPhone 5s and the iPhone 6, 

not the freaky-fast second-gen Touch 

ID on the iPhone 6s. But thanks to 

the iPhone SE’s A9 chip, its Touch ID 

button unlocks the phone faster than 

the iPhone 6’s, just not quite as fast 

as the iPhone 6s’s.

And of course, the 4-inch screen 

is easier to reach with your thumb 

while you’re holding the phone 

one-handed. Size was the biggest 

deal for me when using this iPhone. 

Suddenly I could drop my phone 

into any pocket again (pockets on 

women’s pants are small, too), and 

comfortably reach the whole 

screen. The last time I used my 

Apple Watch to ping the iPhone SE 

so I could find it, it was already in 

my back pocket!

PHOTOGRAPH BY ADAM PATRICK MURRAY

REMEMBER THE iPHONE 

5S? This looks and 

feels just like it—only 

now in pink. (Excuse 

me, rose gold.)

SUDDENLY  
I COULD DROP  
MY PHONE INTO  
ANY POCKET AGAIN 
(POCKETS ON WOMEN’S 
PANTS ARE SMALL, TOO),  
AND COMFORTABLY REACH 
THE WHOLE SCREEN.
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EXCELLENT CAMERA
Apple gave the iPhone SE the same 

rear-facing camera as the iPhone 

6s: It takes 12-megapixel stills, 4K 

video, and even Live Photos. Since 

the screen doesn’t have the pres-

sure-sensitive 3D Touch feature, 

you just press and hold to make a 

Live Photo animate. The camera 

launches fast, and takes photos 

fast. I was very pleased with the 

camera’s performance, which you 

FEATURE     RE V I E W ED: i PHON E SE

THE iPHONE SE (left) 

captured all the detail 

and colors as the 

iPhone 6s (right) did.

SINCE THE iPHONE SE 

supports Live Photos 

and all the same 

photo features as its 

bigger siblings, you’re 

not giving up much. 
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can see in the side-by-side shots 

taken with the iPhone SE and the 

iPhone 6s.

The front-facing camera (which 

Apple calls the FaceTime HD camera) 

is the same as on the iPhone 5s, 

however. It takes 1.2-megapixel stills, 

compared to the 5-megapixel 

FaceTime HD camera on the 6s. So if 

you are a real selfie nut, you might 

want the extra pixels of the flagship 

phone. But the FaceTime HD camera 

can use the SE’s screen as the flash, 

and doing so tended to smooth out 

some of the noise, so those photos 

look pretty good too. Since I only 

take a fraction of my photos with the 

front-facing camera, its weaker specs 

didn’t bother me at all.

NO 3D TOUCH?  
NO BIG DEAL
3D Touch is probably the biggest 

trade-off. On the new iPhone 6s, 3D 

Touch lets you “deep press” the 

screen for more options. Deep-press-

PHOTOGRAPH BY ADAM PATRICK MURRAY

NO PROTRUDING 

camera bump, hooray! 

THE CAMERA 
LAUNCHES FAST, 
AND TAKES 
PHOTOS FAST.
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ing an icon on the home screen can 

reveal Quick Actions, which are 

shortcuts into different parts of an 

app. Once inside an app, deep-press-

ing controls the “peek” and “pop” 

maneuvers: You can peek at an 

image, email, or search result without 

opening it all the way, and then press 

a little more on that preview to pop it 

open into a full-screen view.

It’s fun when you get the hang of it, 

but it’s also one of those things I use to 

demo the iPhone 6s to people, and 

then promptly forget about the rest of 

the time. So I didn’t think I’d miss it on 

the iPhone SE, and for the first couple 

of days I really didn’t. I found myself 

trying a couple Quick Actions a few 

days into my test, and being temporar-

ily confused that they didn’t work. I was 

only a little bummed when I remem-

bered the SE doesn’t support 3D 

Touch, but at the end of the day, that 

feeling only served to remind me that 

the SE is such an all-around powerful 

performer that I just forgot it didn’t do 

everything my iPhone 6s can do.

BOTTOM LINE
If you are still rocking the iPhone 5s, 

5c, 5, or earlier, your upgrade is 

here, and I think you’ll find it was 

FEATURE     RE V I E W ED: i PHON E SE
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I ONLY MISSED 3D 

Touch very briefly, 

and if you’ve never 

had it, you won’t 

miss it at all. 

worth the wait. If you have an 

iPhone 6 or later and you’ve always 

hated its size, this might feel a lot 

better—its performance isn’t a down-

grade, just its physical dimensions. 

The iPhone SE is powerful, speedy, 

and a worthy addition to the low end 

of the lineup. ■

THE iPHONE SE 
IS POWERFUL, 
SPEEDY, AND A 
WORTHY 
ADDITION TO 
THE LOW END 
OF THE LINEUP.
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WORKING MAC Tips, Tricks, and Tools to Make You 
and Your Mac More Productive

How to set up a redundant 
backup system
Time Machine, cloning, or the tiger?

BY GLENN FLEISHMAN
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Thomas Staton asks about backup 

strategies:

Since I have two backup drives, 

should I use Time Machine on 

both, or use cloning hardware on 

one and Time Machine on the 

other?

I’m a great fan of belt, suspenders, 

duct tape, and a spare belt. Time 

Machine and clones have different 

purposes, though you can use them 

to the same end in the right case. If 

you have a non-recoverable drive 

failure, you can 

either use a 

clone or a Time 

Machine drive 

to restore to the 

last backed-up 

point.

Time 

Machine’s 

advantage is 

twofold in the 

right case. First, it’s routinely backing 

up, so even as you work, some files 

are being written in backup form. 

Second, it has archives of previous 

versions of the same files.

However, using two drives as Time 

Machine destination provides 

redundancy in case one fails, but it 

doesn’t provide diversity. If some-

thing goes wrong with one Time 

Machine backup, it’s possible the 

other would be corrupted for the 

same reason. And you’re not getting 

enough differential between them to 

have a more recent restore point, 

either, even if both work perfectly.

Cloning with something like 

Carbon Copy Cloner (bombich.com) 

or SuperDuper (go.macworld.com/

superduper) typically happens on a 

schedule, so you won’t have the 

latest version of a dead drive, but 

one that could be several hours out 

of date. Standard cloning software 

doesn’t archive older file versions, 

either.

However, 

because I store 

email remotely, 

and use Drop-

box and other 

synchronized 

data tools, I’m 

more con-

cerned with 

getting back to 

work faster than 

I am having an up-to-the-minute (or 

-hour) restore point of everything. 

Dropbox will resync after I restore.

I like the flexibility of a clone 

because Time Machine can be fussy 

and sometimes restores will fail for 

no diagnosable reason. I prefer 

using Time Machine to restore older 

file versions, and clones to restore 

entire drives. This is especially easy 

when the clone is written to a 

TIME MACHINE 
AND CLONES 
HAVE DIFFERENT 
PURPOSES, THOUGH 
YOU CAN USE THEM 
TO THE SAME END IN 
THE RIGHT CASE.
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volume as a sparse disk image, 

which can be mounted by Disk 

Utility from OS X Recovery. Last 

year, I had a recent clone on hand 

after a drive failure (which I’d made 

partly because I thought the drive 

was nearing death), and was able to 

boot into OS X Recovery, select the 

disk image from an external 

mounted drive, and write that to my 

new drive, and then boot from it.

Beyond the above, I strongly 

recommend you keep a recent 

backup, preferably in encrypted form, 

somewhere else. With two drives, 

you might use Time Machine as your 

regular backup, and cycle in the 

second drive from another location 

or a safe-deposit box for regular 

clones. You could also buy an 

inexpensive third drive, one that’s 

USB-bus powered for compactness, 

just for this purpose. Multi-terabyte 

portable drives where you don’t 

need high performance for use as an 

active drive are pretty cheap.

I also recommend having some 

form of hosted online backup, so that 

in the event of total destruction of 

your equipment, your files still live on 

in the ether. Backblaze (backblaze.

com), for instance, lets you back up 

your files and lock the encryption key 

with a passphrase that they never 

have access to, making you the only 

weak leak in the encryption chain. 

Many folks who have few applica-

tions installed rely on cloud services, 

and use web apps and Google Drive 

or Dropbox to make sure they have 

the very latest versions of every 

document they’re working on. ■
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How to filter email
Get control of your messages in OS X’s Mail, iCloud, and Gmail.
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There are many ways to filter email: 

in some cases you can filter your 

email directly on a server, so filtered 

messages don’t go into your inbox at 

all, making it easier to deal with email 

on your iOS device. And you can 

filter email on your Mac, in your email 

program.

In this article, I’ll look at filtering 

email on iCloud and Gmail, two of the 

most popular email services, and 

CREATE A new 

mailbox on 

iCloud.

W
hile email is slowly being replaced by other forms 
of communication such as text messaging, or 
services like Slack, it is still the main way people do 
business. The average user receives about 90 

emails per day, a dozen of which are spam. To help work efficiently 
with email, it’s a good idea to filter some of your messages. You 
may want to have separate mailboxes for your work and personal 
emails, or specific mailboxes for emails from close friends. If you’re 
using email for business, you may want to filter emails by client, or 
put support emails in one mailbox, and sales queries in another.

explain how you can create filters in 

Mail. It’s easy to set up filters, and it 

can make your email life a lot easier.

FILTERING IN MAIL

I’ll start with Mail on OS X, since, if 

you use this app, you’ll want to set up 

folders or mailboxes there that your 

server-side filters will use as well. If 

you don’t have multiple mailboxes, 

create a new one by choosing 
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Mailbox → New 

Mailbox. Select a 

location; if you 

choose On My Mac, 

you won’t be able 

to use filters on 

your server, so 

choose your email 

provider, such as 

iCloud or Gmail. (I 

won’t cover setting 

up filters with other 

email providers; 

check their docu-

mentation to find 

out how to do this.)

Click OK, and you’ll have a new 

mailbox both on the server and in 

Mail. You’ll be able to move mes-

sages there from within Mail, in the 

iOS Mail app, and on iCloud.com.

Choose Mail → Preferences, then 

click Rules. Click Add Rule and then 

give your rule a name. Choose 

something from the condition menu, 

such as From, To, Any Recipient, 

Date, and more, and enter the text 

you want to filter. This could be a 

keyword in the subject, or an email 

address, or a client’s name. Choose 

what to do with the message; in the 

example, I’m moving messages sent 

to my iTunes Guy address to a 

specific folder. And then I add the 

condition Stop Evaluating Rules, so 

no other rules affect the message.

For more ideas of rules you can 

create in Mail, read Five Essential Mail 

Rules (go.macworld.com/5mailrules).

When you use filtering on your Mac, 

your email is filtered there as long as 

the Mac is running, and you’ve got Mail 

open. Even if you’re not home, if your 

Mac is on, Mail filters your messages, 

making it easier to deal with mail on 

your iOS device. You may not want to 

leave your Mac running all the time, 

but if your Mac supports Power Nap, 

you can let your Mac sleep, and it will 

check for new email from time to time, 

and filter it while doing so. To activate 

this, choose the Apple menu → System 

Preferences → Energy Saver, and then 

click Enable Power Nap.

FILTERING ON iCLOUD.COM

To filter messages on iCloud.com, log 

into iCloud.com on the web. Click on 

Mail, then click the gear icon at the 

HOW TO FILTER EMAIL

HERE’S A SIMPLE 

RULE in Mail: it 

looks for a specific 

recipient, then moves 

messages to a folder.
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bottom left of the page. Choose 

Rules, and then Add A Rule. Choose 

a condition from the first menu. You 

can choose who a message is from, 

who it’s addressed to, Cc’d to, or you 

can have iCloud filter emails that 

contain specific words in the subject.

In the Then menu, you can tell 

iCloud to move the message to a 

folder, to the Trash, or forward it to 

another email address. For the first 

choice, you then select a folder; for 

the third option, you enter an email 

address for forwarding.

Click Done, and iCloud will filter 

these messages on the server, 

placing them in the folder(s) you’ve 

selected.

The advantage to filtering email on 

the server is that your Mac doesn’t 

need to be running. When you check 

email on your iPhone or iPad, your 

inbox won’t be as cluttered. You can 

still access the filtered emails by 

checking specific folders in Mail on 

your iOS device, but your inbox won’t 

contain as many messages.

FILTERING ON GMAIL

If you use Gmail, you can also filter 

FILTERING MESSAGES 

on iCloud.com means 

they won’t show up in 

your inbox, even on 

your iOS devices.

http://www.softgozar.com


100

WORKINGMAC

messages. Click the 

gear icon, then 

choose Settings. Click 

Filters and Blocked 

Addresses, and then 

click Create A New 

Filter. Enter the term 

you want to use in the 

appropriate field: 

From, To, Subject, Has 

The Words, etc.

Click Create Filter 

With This Search, 

and then choose 

how you want 

messages matching 

this filter to be 

processed. Gmail 

gives you lots of options for this: the 

emails can be archived, marked as 

read, forwarded, deleted, and much 

more. Click Create Filter to save the 

filter.

As with iCloud, these server-side 

filters act on messages before they 

get to your Mac or your iOS devices. 

This is useful if you want to keep 

your iPhone’s inbox from getting 

HOW TO FILTER EMAIL

overloaded with messages you 

don’t need to see right away.

No matter which method you use, 

you’ll find that filtering your email can 

save you a lot of time, and keep your 

inbox less crowded. Try it out, on 

your Mac, or on your email server, 

and see how much easier it can be to 

deal with email. ■

CREATE A FILTER in 

Gmail, and then 

choose how Gmail 

processes messages 

matching your filter.
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How to use the Finder window 
toolbar to save time
Tweaking the Finder toolbar can help you become more productive.

BY KIRK McELHEARN
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Tweaking the Finder toolbar can help 

you become more productive. You 

can add buttons for functions you 

use often, ones that might be harder 

to access via menus. You can add a 

specific button that offers most of the 

same menu items as the Finder’s 

contextual menu; this is great if you’d 

rather click a button than right-click 

or Control-click. And you can use the 

Back and Forward buttons to move 

through windows or tabs you’ve 

viewed, and use the Finder view 

buttons to change Finder views.

CUSTOMIZE THE  

FINDER TOOLBAR

To start with, you should check out 

which buttons are available in the 

Finder toolbar. By default, you see 

the Back and Forward buttons, the 

four View buttons, the Arrange 

button, the Action button, the Share 

button, the Edit Tags button, and a 

THIS IS THE default button set for the Finder toolbar.

M
any of the apps on your Mac have a toolbar; that’s 
the gray section at the top of the window that con-
tains a number of buttons and, perhaps, a search 
field. You see this in Safari, Mail, the iWork apps 

(Pages, Numbers, Keynote), and even in the Finder. The buttons 
available in these toolbars let you quickly access some of the 
most common functions of their respective apps.

Search field.

If you simply want to thin out the 

toolbar, you can remove any of these 

buttons easily. Just press and hold the 

Command key, and then drag one of 

the buttons off the toolbar. And if you 

want to rearrange the buttons—you 

might prefer the Search field to be on 

the left, for example—press and hold 

the Command key and drag a button 

to where you want it.

But you can do a lot more than just 

move and remove buttons. You can 

add a number of other buttons and 

fields to the Finder toolbar. To see 

these, choose View → Customize 

Toolbar. You’ll find a number of buttons 

for actions that you may use frequently.

To add any of these items to the 

toolbar, just drag and then release 

them where you want them to live. 

You can move them around, and you 

can add spaces; you’ll see there are 

two types of spaces—a regular, 
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fixed-width space, and a flexible 

space that changes its size according 

to the amount of room there is.

Here are a few of the buttons you 

may or may not want to use in the 

Finder toolbar:

> Action: The Action button is part 

of the default button set. It’s the 

equivalent of the contextual menu, 

which you display by right-clicking or 

control clicking an item. The Action 

button’s menu changes according to 

what is selected, offering a range of 

actions you can perform on an item.

> View: This button lets you 

change Finder views. (Learn about 

Finder views on page 106.) However, 

you may never or rarely want to 

change your windows’ views. If so, 

you can remove this button, saving a 

lot of space. Just drag it off the 

toolbar and you can still change 

views from the Finder’s View menu 

or by using keyboard shortcuts.

> Share: The Share button lets you 

quickly share items in the Finder, 

sending them via Mail or Messages, 

or sharing them on Twitter or Face-

book, or to other apps or services. 

You can access this feature from the 

contextual menu (right-click an item 

and choose Share, then choose a 

service from the submenu), but if you 

share a lot, it’s good to have this 

button handy.

> Edit Tags: If you use Finder tags, 

you’ll find that this button streamlines 

adding and changing tags.

After you’ve made your choices, 

click Done. Note that from the Show 

menu at the bottom left of the 

Customize sheet, you can choose to 

HOW TO USE THE FINDER WINDOW TOOLBAR

CLICK AND DRAG the 

buttons you want 

from this window to 

the toolbar.
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display Finder toolbar buttons as Icon 

Only, Text Only, or Icon And Text. I 

find Icon Only to be the most eco-

nomical; it’s better than just seeing 

the names of the buttons, and once 

I’ve remembered what each button 

does, it saves space by not display-

ing their names below the icons. Try 

the different options and choose 

what works best for you.

QUICK ACCESS TO APPS, 

FILES, AND FOLDERS

In addition to the stock toolbar 

buttons, you can add any file, folder, 

or app to the Finder toolbar. This 

gives you quick access to items you 

use often. To add an item to the 

toolbar, hold down the Command key 

and drag it to the toolbar. You can 

drag it to the exact position where 

you want to use it. When you release 

the Command key, the icon will stay 

where you want.

This is very useful if there’s an app 

you want to access quickly: it can be 

quicker to drag a file to an app’s icon in 

the toolbar than, say, dragging a file to 

the Dock, which is further away. Or you 

may have a network volume you 

connect to regularly; just drag its icon 

to the toolbar, and you’ll be able to 

access it in one click from any window.

Take advantage of the Finder’s 

flexible toolbar. It can save you time 

and make you more productive, 

giving you quick access to the 

functions you use most. ■

YOU CAN ADD files, 

folders, and apps to 

the Finder toolbar. 

Here’s my Finder 

window, with 

two apps and an 

Automator workflow 

I use often, and a 

folder I want to access 

quickly, but don’t 

need in the sidebar.
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Get the most out of Finder views
You can save time by learning when to use Icon, List, Column, or Cover Flow view.

BY KIRK McELHEARN
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As a prime example, you can use the 

Finder’s View menu options to view 

files and folders in four different 

ways, but most people don’t know 

why they’d bother. They stick to one 

view for all their windows when, in 

fact, there are valid reasons to use 

each. Here’s how to use the right 

view at the right time, and save time 

and trouble in the process.

FLEXIBLE ICON VIEW

OS X uses Icon View by default. 

Select it by choosing View → As 

Icons, pressing Command-1, or 

clicking on the Icon View button in a 

ICON VIEW LETS YOU 

work with your files 

and folders much 

as if they were on 

an actual desktop. 

If things get messy 

(as they have here), 

choose View → Clean 

Up, and the icons 

snap to a grid.

O
ne program you use all the time is the Finder. It’s your 
Mac’s filing system, organizational structure, and 
overseer. We all know how to open, move, and copy 
files, but most of us go about our business without 

ever considering the most efficient way to get these tasks done.

Finder window’s toolbar. This view 

shows your files as familiar icons.

Some people like Icon View because 

they can arrange file icons as if they 

were objects on a desk. For example, 

one group of related items on the left 

side of a Finder window, and another 

on the right. Some people don’t like 

Icon View for the same reason; icons 

can get messy and confusing. They’re 

easy to straighten up, though. Choose 

View → Clean Up and the icons snap 

into a grid formation.

ICON OPTIONS

You can not only place icons wherever 
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you please, but also change how this 

view looks. From the View Options 

inspector (View → Show View Options 

or Command-J), you can, for example, 

adjust grid spacing (how close together 

icons appear) and choose a color or 

picture as a folder background.

Another option lets you set, say, a 

green background for folders con-

taining important files, and a blue 

background for folders containing 

documents you need to edit. Just 

press Command-J, click on Color (in 

the Background section near the 

bottom of the 

View Options 

window), and 

then click on the 

color well. When 

the color picker 

appears, choose 

your color and 

click OK. With 

different back-

grounds, you can tell multiple win-

dows apart at a glance.

The options you set in the View 

Options inspector apply only to the 

selected folder, unless you select the 

Use As Defaults option; this applies 

the change to all folders that use the 

current view and that haven’t already 

been customized in some way. (It will 

also apply to new Finder windows 

you open using File → New Finder 

Window or Command-N.) This can 

come in handy when a certain option 

proves useful for only certain types 

of files. For instance, choose the 

Show Icon Preview option to make 

the Finder display a thumbnail of 

files’ contents (for file types it’s 

familiar with). Since this is most useful 

for photos and videos—you can see 

their contents at a glance—you can 

turn previews on only for folders that 

contain them.

Likewise, you might use the Arrange 

By option in different ways depending 

on a folder’s contents. Open your 

Downloads folder, choose View 

Options, and then 

select Date 

Modified from the 

Arrange By menu 

to see the most 

recent files at the 

top left corner of 

the folder. In a 

folder containing 

files you want to 

copy to an external drive, you might 

choose Arrange By Size to see the 

largest files first, so you can choose 

which ones you can fit on the disk.

COMPACT LIST VIEW

If Icon View were the only choice for 

organizing files, many Mac users 

would be lost. Lots of people prefer 

the more compact List View (View → 

As List or Command-2). In this view, 

you see filenames, dates (when the 

files were either modified or created), 

FINDER VIEWS

IF ICON VIEW WERE 
THE ONLY CHOICE 
FOR ORGANIZING 
FILES, MANY MAC 
USERS WOULD BE 
LOST. 
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sizes, and more. The View Options 

inspector lets you choose which 

columns to display.

Since List View is made up of 

columns, it’s easy to change the 

order your files appear in. Just click 

on a column header to choose an 

attribute to sort by. For example, click 

on Date Modified to see the most 

recently changed files at the top of 

the list, and click on that header 

again to change the sort order and 

show the oldest files at the top.

You’ll probably find List View most 

practical for folders that contain lots of 

files you want to be able to sort by 

name, date, size, or kind. You have the 

option of displaying a preview icon as 

part of the list. List View has two icon 

sizes; small ones are tiny, and large 

ones are 24 pixels wide. Although 

they can provide an at-a-glance way 

to see what types of files you’re 

dealing with, these icons aren’t really 

big enough to be very helpful.

If you use List View a lot, a better 

way to see file previews is to open a 

special Info window (Command-

Option-I). Unlike the Info window that 

displays when you press Command-I, 

this window stays visible, changing 

its display whenever you click on a 

new file. You can see good-sized 

previews of your images here, as 

LIST VIEW MAY NOT be very exciting to look at, but its columns can give you a lot of information about a file or folder at a glance. You 

can tell the files here are sorted by name, because the Name in the column header is slightly bold, and there’s an arrow at the right 

of the column indicating the sort order.
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well as play music and movie files by 

clicking on previews. You can also 

open any file, folder, or application by 

double-clicking on this preview.

One of List View’s biggest advan-

tages is that you can open folders 

and browse their contents in the 

same window. Click on the disclosure 

triangle next to a folder’s name, and 

the folder’s content appears below. 

You can open and close as many 

folders as you want, and go to as 

many sublevels as you want. To close 

a folder, just click on the disclosure 

triangle again.

POWERFUL COLUMN VIEW

I know many people who swear by 

Column View. One Macworld col-

league jokingly said to me, “You 

mean there are other views?” Col-

umn View (View → As Columns or 

Command-3) shows your files within 

FINDER VIEWS

their hierarchy; you see the folders 

and files above and below your 

current folder, each level in a sepa-

rate column. This makes it easy to 

move files without having to open 

multiple Finder windows. Just drag a 

file from one spot to another in the 

hierarchy. So Column View is helpful, 

for example, when you need to zip 

up and down your Mac’s hierarchy to 

find specific files and move or copy 

them to other locations.

However, this view can get confus-

ing, especially because when you 

click on a folder, the Finder may shift 

all of the window’s columns to 

display its contents. You may have to 

scroll back and forth horizontally to 

keep track of things.

You can arrange files according to 

name, date, size, and so on in 

Column View by choosing these 

options from the View Options 

COLUMN VIEW LETS 

YOU see at a glance 

where your files are in 

your Finder hierarchy. 

Even though you can’t 

view many details 

about groups of files, 

the preview column 

gives you a lot of 

information about 

individual files.
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window, but only the items’ names 

are displayed. So Column View is not 

useful when you need more informa-

tion than just names. However, you 

can choose to see a useful preview 

column, which shows a large thumb-

nail of the selected item. And here 

you can preview photos and videos 

along with all the file information List 

View provides, such as size, creation 

and modification dates, and more.

TAMING COLUMN VIEW

Column View can be tricky. For 

example, it can be hard to figure out 

how to make new folders appear 

where you want. This is just a ques-

tion of being in the proper column. 

Make sure you click on an item (not a 

folder) in a column before pressing 

Command-Shift-N to make a new 

folder in that column. If you click on a 

folder, the new folder will appear 

inside the selected folder.

If you have trouble with filenames 

getting cut off in columns, there are 

a few quick ways to make them 

legible. Resize a single column by 

dragging the very bottom of one of 

the column dividers until you can 

see the longest filename. Alterna-

tively, double-click on the divider to 

make it that size automatically. You 

can Option-double-click to make all 

columns as wide as the widest 

column in the Finder window, but 

this can make the window unman-

ageably huge. It’s usually better to 

resize all the columns at the same 

time by pressing and holding the 

Option key while you drag.

When you use Column View in an 

Open or Save dialog box, you have 

one more way to do this. Control-

click on the column divider icon (at 

the bottom of the divider), and you’ll 

see a contextual menu. Choose from 

Right Size This Column, Right Size All 

Columns Individually, or Right Size All 

Columns Equally.

QUICK AND PRETTY  

COVER FLOW VIEW

Cover Flow View gives you a differ-

ent way to view your files. Choose 

View → As Cover Flow or press 

Command-4 to view your files and 

folders as graphics in the top section 

of a window; the same files are 

shown in a list in the window’s 

bottom section. (You can’t change 

that bottom section’s appearance.) 

Cover Flow is not very useful for 

everyday file management because it 

limits the number of files you can see 

at a time.

HAVING TROUBLE WITH FILENAMES 
GETTING CUT OFF IN COLUMNS? 
THERE ARE A FEW QUICK WAYS TO 
MAKE THEM LEGIBLE. 
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That said, Cover Flow View is a 

wonderful tool when you need to sift 

through a folder of photos, videos, or 

even text files, as long as OS X can 

display the contents of those files. If 

you increase the size of your window, 

Cover Flow View can display huge 

previews. This is helpful, for example, 

when you need to find a Word 

document or a Numbers spreadsheet 

with specific content at the begin-

ning. (No matter how big the preview 

is, Cover Flow displays only the 

document’s first page.)

SEE MORE WITH QUICK LOOK

All four views can display some kind 

of preview, but nothing compares 

with Quick Look. Use it in any view 

by selecting a file and pressing the 

spacebar. If the Finder can read the 

file type, a Quick Look window pops 

open and displays the file’s contents. 

You don’t have to wait for an app to 

load or the file to open, which means 

that you save a lot of time when you 

just want to glance at some files to 

find the one you’re looking for.

Quick Look can be more or less 

interactive for different types of files. 

For Apple Numbers and Microsoft 

Excel workbooks, you can click on 

worksheets to see their contents. You 

can scroll through Microsoft Word 

documents and Apple Keynote 

presentations, and you can click on 

links in HTML pages. Have a folder 

full of files you want to examine 

closely but quickly? Select the files 

and then press the spacebar.

You’ll see a number of tools 

displayed on the Quick Look window. 

With some files, such as PDFs, Word 

files, Pages files, etc., you’ll be able 

COVER FLOW ISN’T 

practical for 

managing files and 

folders, but it can 

be useful when you 

need a quick way to 

look through a bunch 

of files that OS X can 

preview.

WORKINGMAC FINDER VIEWS
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to view thumbnails of the files’ pages. 

If you’ve selected multiple files, click 

on the Previous and Next arrows to 

move through your files. Click on the 

Index Sheet button to see all the files’ 

previews at once, or click the Full 

Screen double-arrow button to make 

the preview fill your screen. If you 

decide that you want to preview a 

different file, don’t close the Quick 

Look window; rather, just click on a 

different file. The Quick Look window 

will update to show the selected 

item. And click the Open With button 

at the top of the window to open the 

file with its default app. There’s also a 

share button at the top right that lets 

you send it to a friend by email or 

Messages, share it on Facebook or 

Twitter, and more.

One disadvantage of Quick Look is 

that its floating window appears only 

when you’re in the Finder. If you switch 

to another program, it disappears. It 

doesn’t close, though; just switch back 

to the Finder to see it again. Press the 

spacebar to dismiss it.

INCREASE YOUR FINDER 

SMARTS

You spend a lot of time in the Finder, 

so learning about its many possibili-

ties can save you time and give you 

more power over your files and 

folders. Mastering Finder views is 

one of the first steps to becoming a 

Mac power user. ■

THE QUICK LOOK WINDOW lets you see into your files, and, for some document 

types, scroll through thumbnails of their pages.
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PLAYLIST Everything You Need to Know About iPods, 
iTunes, and Mac-Based Entertainment

Why is so much music available to stream, and so few movies and TV shows?

BY KIRK McELHEARN

Why video streaming will never 
be like music streaming
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HOW MANY SONGS  

AND MOVIES?

When you check out music streaming 

services, they all try to lure you by 

saying how many “songs” they have. 

Apple Music has more than 30 

million songs, Spotify has about the 

same number, and Deezer claims to 

have 40 million.

But streaming video services 

(those with a fixed monthly fee for 

But if you want to check out the 

latest albums on Apple Music or 

Spotify, just look at what’s new. You’ll 

have almost all of the biggest hits, in 

every major genre, along with most 

artists’ full catalogues. You want to 

hear an old Rolling Stones album? No 

problem.

Why the discrepancy? Why is so 

much music available to stream, and 

so few movies and TV shows?

I
t’s Friday night, and you want to kick back and relax after a 
long week’s work. You fire up your Apple TV and click on 
Netflix to find a movie to watch. Maybe you like Denzel 
Washington, and want to see one of his great movies. Search 

for Denzel, and what do you find? Four films, and not the best. No 
Malcolm X, no Philadelphia, no Hurricane, Training Day, or Inside 
Man. They’ve got Flight, but they don’t have American Gangster 
or The Taking of Pelham 123. (However, if you want to pay for a 
rental, the iTunes Store has 41 of his movies...) 
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Sure, music streaming services 

count songs, not albums—similar to 

the way Amazon and Netflix count 

TV series—but if you assume an 

average of ten songs per album, 

that’s still three million albums 

compared to fewer than three 

thousand movies.

What if Apple gets into the game 

with a subscription streaming video 

service? Would they have any more 

titles available for a subscription 

service? Most likely not.

WINDOWING

The big difference between the two 

types of streaming is licensing. While 

it’s easy for a large or small record 

unlimited streaming, such as Netflix 

and Amazon Prime Video) are 

nowhere near as proud of citing the 

size of their collections. Amazon 

claims that they have 15,000 films and 

TV episodes available to stream as 

part of Amazon Prime Video, but, 

when the service launched in the U.K., 

I examined what was available, and 

found that there were only 2,269 

movies and 938 TV series (go.

macworld.com/amazoninflates). 

Amazon counts each episode of a TV 

series as one of their 15,000 titles. 

According to FlixList (flixlist.co), Netflix 

has just over 15,000 titles as well, 

counting the same way Amazon does; 

they currently have 2,680 movies. 
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label to release an album to stream 

on Apple Music or Spotify, movie 

releases obey a logic that is only 

understood by Hollywood’s creative 

accountants. Movies and TV shows 

are released in a Byzantine way to 

benefit from “windowing,” which 

allows the producers to exploit their 

work as efficiently as possible. Each 

step of the release schedule has very 

different returns, and is calculated to 

make the most profit possible.

With a record album, the release 

schedule is generally: Release to CD, 

download, and streaming, at the 

same time.

There are some exceptions, but 

not many. Not all artists stream their 

music, and some labels won’t play 

the streaming game at all (such as 

the jazz/classical label ECM, or the 

classical label Hyperion). And an 

artist can choose to sell an album on 

CD and by download, and not clear it 

for streaming right away, as Taylor 

Swift has done recently. But with 

most music, the release schedule is 

all at once, though, with some 

albums, not every track is available to 

stream right away (go.macworld.com/

amtrackavails).

Movie windowing, on the other hand, 

generally follows a much more com-

plex schedule, which is partly based on 

the history of movie distribution.

> Theatrical release, which lasts up 

to around four months.

> DVD and Blu-Ray release, as well 
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as VOD (video-on-demand) release; 

these are exclusive for a few months, 

sometimes longer.

> Pay TV availability, starting 

around six months after release, and 

lasting potentially for several years.

> Free-to-air TV.

> SVOD (subscription video-on-

demand), or all-you-can-watch 

streaming.

This windowing schedule is differ-

ent for movies that are straight-to-

Netflix, or movies and TV series 

produced by Netflix, Amazon, Hulu, 

and other services. In addition, after a 

while, movies and TV shows are 

pulled from streaming services, in 

order to (hopefully) continue to sell 

DVDs and Blu-Rays (though many of 

these get discounted as time goes 

on). That’s why a movie you added to 

your watchlist last month may be 

gone when you finally get around to it.

Windowing can be even more 

complex, as there have recently 

been films released on Netflix before 

or simultaneous with theatrical 

release, so this system is undergoing 

changes. But it will be a long time 

before you 

can stream 

any movie 

you want. 

The amount 

of money 

involved in a 

film is several 

orders of magnitude higher than that 

required to make an album, and 

Hollywood accountants are going to 

make sure they optimize their returns 

at every step.

In the meantime, you’ll keep on 

spending that “Netflix hour”—the 

time you waste looking for a movie to 

watch on your subscription service—

before you give up and rent a movie 

on the iTunes Store. ■

IT WILL BE A LONG 
TIME BEFORE YOU 
CAN STREAM ANY 
MOVIE YOU WANT. 
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— EINSTEIN
  adopted 12-09-10

SURE,
AT FIRST I WAS A LITTLE TAKEN ABACK 

BY THE WHOLE PEEING STANDING UP THING. 
BUT I TAUGHT HIM TO THROW A STICK 

AND NOW HANGING OUT WITH HIM
IS THE BEST PART OF MY DAY. 
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How to adjust 
left/right audio 
balance in iOS
A reader would like to compensate for hearing 
loss by rebalancing sound on his iOS device.

BY KIRK McELHEARN

PLAYLIST
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As a general tip, if you’re looking 

for whether a setting exists, Settings 

has a slightly hidden search feature. 

Swipe down slightly from the top, 

and you can tap in any potential 

keyword. Enter bal and the nested 

balance setting appears as a match. 

Tap, and you leap right to it. ■

Apple has offered a left/

right audio balance for 

several iOS releases, but it 

doesn’t make it obvious 

where to find it. It’s not in 

Sounds, but in Accessibil-

ity (Settings → General → 

Accessibility). Swipe down 

to the Hearing section, and 

you’ll find a number of 

options. All iOS devices 

can adjust left/right 

balance.

But you’ll also see 

settings for working with 

Bluetooth-connected and 

other hearing aids, for 

mono audio, and to remove 

phone noise cancellation, 

which can affect the quality of calls 

negatively in some cases.  

Accessibility is a misnomer, 

because the section is full of useful 

customization and controls that are 

useful for everyone, not just people 

with a specific lacuna, like a visual or 

hearing impairment.  

R
ichard Crouse writes in about audio balance: “I have 
hearing loss in my right ear. If I turn up the volume to 
hear in my right ear, the left ear is dangerously loud.”
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PLAYLIST

Answers to your questions about Apple’s media app.

BY KIRK McELHEARN

Ask the iTunes Guy: 
Hide iTunes 
features, finding 
songs, and more
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Store, Apple Music, radio, and a 

whole lot of other features.

Fortunately, you can choose which 

of these features iTunes displays. If 

you’re tired of seeing icons and 

buttons you don’t use, you can hide 

them. When you do this, you also 

prevent accidentally clicking a button 

that takes you somewhere in the 

iTunes Store with no easy way to get 

MINIMAL iTUNES

Q: I only use iTunes to listen to 

music, and I find that there are just 

too many buttons in its interface. Is 

there any way I can simplify this?

A: iTunes does have a lot of features. 

It handles many media kinds: music, 

movies, TV shows, apps, podcasts, 

and more. And there’s the iTunes 

S
ometimes, you want to use iTunes just to listen to 
music, and not be bothered by the app’s many other 
features. In this month’s column, I explain how you can 
make a minimal iTunes, hiding many of the features 

you don’t use. I also look at what you can do when you’ve got 
too much media to fit on your hard drive; how you can find (or 
not find) which songs you’ve “loved” on Apple Music; and 
explain how to fast forward in Apple’s iOS Music app.

YOU CAN MAKE iTunes into a minimal music player by tweaking the app’s preferences and settings. Here’s 

what iTunes looks like when you get rid of all the non-music stuff.
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back where you were. There are a 

few steps to take, but you may find 

that a minimal iTunes is a lot better 

for when you just listen to music.

I’ve explained how to do this in an 

article on my website, “How to Set 

Up Minimal iTunes for Music Only,” 

(go.macworld.com/minimalitunes).

If you want, you can re-add many of 

these features when you want to use 

them; it’s only a few clicks to show or 

hide these buttons and icons.

LOST LOVES

Q: Is there a way to create a smart 

playlist for loved songs which aren’t 

added to My Music?

A: This question is a follow-up from 

a question about using “loves” in 

iTunes (go.macworld.com/itunes-

loves), where I explained how to 

make a playlist of music you’ve 

“loved.” You may listen on the go, 

and tap the little ♥ next to a track or 

album but not think of adding it to 

your library, or not have the time to 

do so. Unfortunately, there’s no way 

for iTunes to create a smart playlist 

for music that’s not in its library. Your 

loved tracks are recorded in your 

Apple Music account, but if you 

haven’t added them to your iTunes 

library, then you may have trouble 

finding them.

Apple Music should have a way of 

showing you all the music you’ve 

loved that you haven’t added to your 

library so you can do so later. It uses 

these loves to fine-tune its recom-

mendation algorithms, but it should 

also have a built-in playlist so you 

can go back and check which songs 

you rated.

FAST FORWARD

Q: I recently switched to an iPhone. 

I am having a difficult time trying to 

find a good MP3 player that will let 

me fast forward through a song. 

Can you recommend something?

A: Pretty much 

every music 

player app on 

iOS, including 

Apple’s Music 

app, allows you 

to do this. Just 

press the  

button and hold 

it; at first, the 

music skips 

ahead in small 

intervals, but if 

you keep hold- 

ing, the scrub-

bing gets faster, 

and you can fast 

forward through 

a song a few 

seconds at a 

time. When 

you’ve reached 

FAST FORWARD 

BY pressing and 

holding the 

button, which is 

surrounded by a 

red square. Scrub 

by dragging the 

playhead, which 

the red arrow is 

pointing at.
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the spot you want, just release the 

button.

Note that you can also manually 

scrub through a track by dragging 

the playhead just below the album 

artwork.

TOO MUCH STUFF

Q: I’ve filled up my hard drive with 

music, podcasts, movies, and TV 

shows. Can I put additional files on 

an external hard drive yet keep 

them in my iTunes library?

A: You can, but the easiest way to do 

this is to move your entire iTunes 

library to an external hard drive. I 

explain how to do so in “How To: 

Move Your iTunes Library to an 

External Hard Drive,” (go.macworld.

com/exhditunes). 

If you don’t want to move the entire 

iTunes library, what you might want to 

do is simply move items you don’t 

currently need in your iTunes library to 

another drive. The files that take up 

the most space are movies and TV 

shows. Find the ones you don’t plan 

to watch in the near future, then drag 

their files from the iTunes window to a 

folder on an external hard drive. Wait 

until the copy has finished, then 

delete the files from iTunes.

This said, if your movies and TV 

shows are purchased from the iTunes 

Store, and your Internet bandwidth is 

fast enough, you might even want to 

delete them entirely from your iTunes 

library. You’ll be able to re-download 

them again when you want to watch 

them, or even just stream them. ■

Ask the  
iTunes Guy
Have questions of your own for the 

iTunes Guy? Email him at itunesguy@

macworld.com for his consideration.
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HELP DESK Answering Your Questions and Sharing Your 
Tips About Getting the Most From Your Mac

Mac 911
Solutions to your most vexing 
Mac problems.

BY GLENN FLEISHMAN

Why your base station and OS X might report  
different Wi-Fi rates

Rich Knudson wants to know why his 802.11ac-bearing iMac from late 

2015 isn’t giving him the performance he expects when connected to a 

new Time Capsule, which also has 802.11ac Wi-Fi networking. He 

compared AirPort Utility numbers to OS X’s hidden display, and writes: 

“The data rate/Tx [transmit] Rate and RSSI [received signal strength] are 

very different between Airport Utility and the extended Wi-Fi data you get 

PHOTOGRAPH COURTESY OF APPLE
126

http://www.softgozar.com


when you option click the Wi-Fi 

icon in the top right menu bar. One 

of the benefits I was expecting with 

my new setup was to connect my 

iMac to the network using wireless-

ac and see a step function 

improvement in data rate/Tx Rate 

speeds.”

A: As someone who has tested and 

used Wi-Fi for 15 years, I was curious 

about this, too. It’s true that a Wi-Fi 

adapter and a Wi-Fi base station 

have asymmetrical parameters. The 

Wi-Fi adapter in a mobile or desktop 

device almost always has a less-

powerful radio and antenna arrange-

ment for reasons of size and battery. 

(Desktop Macs can use more power, 

but they’re relying on similar 

designs.) A base station can produce 

a much stronger signal and its 

antenna arrangement has a design 

optimized for reach and perfor-

mance; it doesn’t have to play nice 

with computer or handheld functions, 

like an adapter does.

So it’s very likely you’ll see an 

adapter report stronger signal 

strength from the base station than 

the base station will report for the 

adapter. A base station can push out 

more power in a focused direction, 

allowing a distant receiver to pick up 

a signal, and it can also have more 

receive sensitivity, allowing a faint 

transmission by the adapter to be 

heard clearly.

But other reported values should 

be the same: If you’re looking around 

the same moment, 

the data rate 

should be identi-

cal, as that’s a 

function of the 

negotiated con-

nection between 

adapter and base 

station. Wi-Fi in all 

its flavors allows 

devices to move to 

faster and slower 

rates as perfor-

mance improves or 

degrades. This 

allows you to 

move closer to or 

farther from a base 

station and maintain a connection. 

The 802.11n and 802.11ac flavors can 

also use variable amounts of fre-

quency—different channel “widths”—

based on the active electromagnetic 

environment in the ranges they’re 

employing. Over very, very short 

intervals, from one frame to the next 

(the wireless data equivalent of a 

packet), raw throughput could vary by 

a factor of four.

If you want to check your own 

values, it’s very straightforward. In OS 

X, hold down the Option key and click 

the Wi-Fi icon (as Rich notes) and 

you’ll see detailed diagnostic and 

OS X DYNAMICALLY 

updates values in its 

Wi-Fi menu for the 

current connection.
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Rich sent screen captures showing 

that the base station thought it was 

connected at a rate of 351Mbps, 

while his Mac said 117Mbps. That’s 

obviously a threefold difference, but 

because of constant rate changes, 

it’s within expected ranges.

To get a better sense of network 

hotspots and performance, you can 

use tools like WiFi Explorer (go.

performance information. In AirPort 

Utility 6, click a base station and hover 

over any entry in the Wireless Clients 

list to reveal connection details. (You 

can also hold down the Option key 

and click Edit, and in the now-

revealed Summary tab, you can click 

the expand triangle in the Wireless 

Clients list to see details as well.)

I asked Apple about this situation, 

as it seemed like there were dispari-

ties. It replied that because Wi-Fi 

environment changes constantly, the 

values represent essentially a 

snapshot of a sliver of time—if the 

snapshot in OS X and AirPort Utility 

aren’t the identical moment (probably 

down to milliseconds), the details will 

vary slightly. AirPort Utility only 

refreshes after launch if you press 

Command-R, then new values are 

loaded.

HOVERING OVER A client 

for a base station 

reveals the last-

updated Wi-Fi details.

THE AIRPORT UTILITY base station configuration dialog’s hidden 

Summary tab reveals client information, too.
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macworld.com/wifiexplorer) and 

NetSpot (netspotapp.com). And if 

you’d like to check actual throughput, 

instead of reported network speeds, 

jperf is your best bet. It requires the 

installation of Java, but not in a Web 

browser, so you’re not exposing your 

self to Web-based or remote attacks. 

You install jperf on a target Mac 

connected via ethernet to the base 

station, and then on a Mac con-

nected by Wi-Fi. You can then set 

one as a server and one as a client to 

run tests.

How to separate iPhone 
pictures in Photos for OS X

Q: Can I search for photos taken 

with iPhone in my Photos library? 

I’ve got over 13,000 photos that I’ve 

tried to keep organized and export 

them to an external drive so that I 

can vacate space on my hard drive, 

but want to keep the low-quality 

iPhone photos separate.

— Jenni Kapanen

A: Yes, you’re in luck! I feel like the 

Smart Album feature in Photos (as in 

iPhoto) has a lot of overlooked 

power. Here’s a great case.

Start by choosing File → New 

Smart Album. Now you can select 

criteria. While there are some iPhoto 

elements missing from Photos for 

OS X (notably related to whether 

any face has been set in a picture), 

you can still create complicated 

chained or independent queries.

For instance, for your purposes, 

you could create two smart albums: 

One would look for all photos taken 

by cameras that aren’t iPhones; the 

other could be only pictures taken by 

iPhones. This would let you sepa-

rately browse through both catego-

ries. (Unfortunately, you can’t create 

a smart album and then create a 

separate one that’s its inverse 

selection.)

Let’s say I want an album that only 

contains photos (not videos) taken by 

any iPhone model. In the New Smart 

Album dialog, I’d choose All from the 

Match menu, as I have two criteria. 

My first is Camera Model set to Starts 

THE CAMERA MODEL criterion lets you select among camera and smartphones 

or make broader matches.

CREATE A SMART album that only includes iPhone images.
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With and then iPhone. (I could also 

select Is and pick specific iPhone 

models in the list.)

Then I’d click the + to add another 

criterion, and choose Photo, set 

matching to Is Not, and choose 

Movie from the category pop-up 

menu. After clicking OK, and I’d now 

see only images taken by any iPhone 

I’ve ever owned.

These criteria can be useful, too, if 

you’re trying to sort or find images 

taken with more particular photo-

graphic parameters. If you want only 

shots at ISO 100 taken at f/2.2, you 

can do that, too. Or, only pictures in a 

certain date range that were taken 

without a flash.

Can you merge synced 
data from multiple Apple 
IDs?

Q: One thing that I don’t fully 

understand is why iCloud can’t be 

used as a solution to this problem? 

Would it be possible for me to set 

up a new, third Apple ID and to 

sync both existing accounts to it 

and then delete them and imple- 

ment the new, third Apple ID on all 

my devices? Everything is in sync 

(which is why I haven’t moved to 

using just one Apple ID before 

now). If I add a new contact on my 

iPhone, it pops up on my iMac. 

Likewise with Calendar entries. 

Also, the 385 physical CDs that 

I’ve uploaded to iTunes on my 

iMac are also there on my iPhone 

and music I’ve purchased from 

iTunes on my iPhone are also on 

my iMac.

— Dara Hogan

A: Dara has a problem that a lot of 

readers share: two Apple IDs that are 

both used for iTunes and iCloud. 

Dara also notes because everything 

is in sync she would rather stay put, 

which is a common one for many, 

and is the reason that I continue to 

use an older Apple ID for iTunes and 

a newer one for iCloud.

So here’s the problem. You can’t 

migrate anything among Apple IDs 

using iCloud or other tools, nor 

migrate your email. You could make 

MAC 911HELP DESK

130

http://www.softgozar.com


sure one Mac (better than iOS for this 

purpose) was up to date with contacts 

and calendars, and you’d use Mail or 

another IMAP-supported mail client to 

download all email that was stored on 

the server to local storage.

If you used iCloud Photo Library or 

iCloud Music Library or iTunes Match, 

you’d want to be sure that 100 

percent of the synced material is 

stored locally on the Mac, too. (In 

iCloud Photo Library, set the iCloud 

preferences to download full-resolu-

tion images. With iTunes, you can 

search for song files stored in the 

cloud through a Smart Album (go.

macworld.com/smartplaylists), then 

select and download all of them.) 

You’d also need to make sure you’d 

cleared out 

iCloud Drive 

of any files 

you need.

Then you 

could disable 

iCloud and 

be sure to 

click every dialog that asks that you 

want to keep information stored 

locally. Now, you can create a new 

Apple ID you plan to use with iCloud 

synchronization and enable synchro-

IN iCLOUD PHOTO Library, set the iCloud preferences to download full-resolution images. 

YOU CAN’T MIGRATE 
ANYTHING AMONG 
APPLE IDS USING iCLOUD 
OR OTHER TOOLS, NOR 
MIGRATE YOUR EMAIL.  
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nization for all the services.

However, a lot of provisos:

> All DRM-protected media pur-

chases and all Mac App Store and 

iOS apps remain locked to the 

accounts through which they were 

originally purchased. 

> If you want to keep using one of 

the emails associated with your other 

Apple IDs—especially to send email 

using that address as the return 

address—you need to keep an entry 

in your mail programs for it. (You can 

forward iCloud email (go.macworld.

com/fwdicloudemail), though, and 

that may be enough of a solution for 

many people.)

> There may be Apple-associated 

or third-party connections to the 

Apple IDs or associated email 

addresses, so you may regularly 

have to log in or enter passwords in 

any case.

If that all works for you, then a third 

Apple ID (or consolidating sync to 

one of the two existing ones) should 

work out just fine.

Of course, the real solution here is 

for Apple to act like a company doing 

business in 2016 and build Apple ID 

migration and merge options that 

preserve media ownership and 

transfer the licenses and consolidate 

previous purchase histories and 

other records. Many, many, many 

companies do this, and some have 

tens of millions of customers, too. 

Until that happens, everything else is 

a second-best measure.

Can you use Wi-Fi and 
ethernet on a Mac at the 
same time?

Q: I have an ethernet connection to 

my FiOS modem/router and it works 

great. Somewhere along the line I 

had to turn on my Wi-Fi as well. 

Don’t remember why. Just curious, 

is it a benefit or a deficit or is it 

neutral to have both connections 

active at the same time?

— Don Smith

A: Don (and Don really exists, I didn’t 

invent him, I swear), that’s a great area 

to discuss. OS X is a well-designed 

modern operating system that for 

MAC 911HELP DESK

THE NETWORK SYSTEM 

preferences pane lets 

you activate multiple 

interfaces at once, and 

see the status of all 

network connections.
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many releases has let you have 

multiple active network interfaces. 

They can be “real” in the sense of 

directly corresponding to physical 

hardware that’s part of or attached to 

a Mac, or “virtual,” as is the case with 

VPNs (virtual private networks).

Typically, they won’t conflict, even 

if you have two or more interfaces 

connected to the same network, such 

as Wi-Fi and ethernet. A few years 

ago, OS X would balk at this; but 

since Mavericks (10.9), I’ve kept both 

active. (You may want Wi-Fi active at 

all times so you can take advantage 

of Continuity features that require 

Wi-Fi, and to use AirDrop.)

OS X automatically sorts network 

interfaces in the Network system 

preferences pane in the order of first 

“connected” interfaces (ones with an 

active signal and IP address), then 

disconnected ones, and finally those 

marked inactive. (You can select any 

interface, click the gear icon, and 

choose Make Service Inactive to 

disable it.)

But you can choose the order in 

which OS X accesses your local 

network and the Internet. Click the 

gear icon and then select Set Service 

Order, and you can drag interfaces 

around in the priority you want OS X 

to use them when they’re available 

and connected.

The most likely scenario for this is 

cascading an ethernet, Wi-Fi, and 

iPhone USB connection with a laptop. 

When you’re plugged into ethernet, 

you don’t want to have to turn off 

Wi-Fi, so you set ethernet as the first 

item in the Service Order. Likewise, if 

you’ve unplugged from ethernet, 

you’d prefer Wi-Fi, but if that’s not 

available either, you want to use your 

iPhone’s hotspot. Setting this order 

means no mucking about when your 

network conditions change. ■ 

Ask Mac 911
We’re always looking for problems 

to solve! Email us at mac911@

macworld.com including screen 

captures as appropriate. 

Mac 911 can’t provide direct email 

responses or answers for every 

question. For that, turn to Apple-

Care, an Apple Store Genius Bar, or 

the Apple Support Communities.
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